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P R E F A C E

About This Manual
Who Should Read This Manual?

This manual describes how to use the software provided with the Chinese Language Kit to 
enter Chinese characters on your Mac OS computer. 

It provides basic instructions for using the software to enter Chinese characters. Some of the 
procedures described in this manual require you to know how to write Chinese characters, 
construct characters using systems of radicals, or spell Chinese characters phonetically using 
Roman characters or Chinese symbols.

To use the Chinese Language Kit you need to know how to use your Mac OS computer. If 
you are not familiar with how to use your computer, see the manual that came with it.

You can use the Chinese Language Kit with application programs that are localized for 
Chinese. To learn how to use these applications and to determine whether they provide 
special features for working with Chinese characters, see the manuals that came with the 
applications.

Where to Get Help

The Apple World Wide Web site provides useful information about Apple’s products and 
services, including help with solving problems you may have with your software. You may 
also find recent updates to Apple software.

http://www.apple.com/
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1
1 About the Chinese Language Kit

What Is the Chinese Language Kit?

The Chinese Language Kit provides software that allows you to enter Chinese characters on 
your Mac OS computer. You can use Chinese characters for the names of files and folders in 
the Finder and as text in documents you create in your application programs. 

Most computer keyboards are designed to type one-byte Roman characters. The Chinese 
Language Kit software adapts your Roman-based keyboard so you can enter two-byte 
Chinese characters on your computer. This software is called an input method, which is 
based on Apple’s WorldScript technology. (For more information about this technology, see 
“What Are Scripts?” on page 14 of this chapter.)

The Chinese Language Kit provides two input methods for the two Chinese writing systems: 
Traditional Chinese and Simplified Chinese. Each system uses many characters, and while the 
characters in each system are related, they are different.

Both the Traditional Chinese and Simplified Chinese input methods provide several input
modes for entering characters. There are three types of input modes based on the way 
characters are written, the way characters sound, and numeric codes for each character.

The next two sections provide general information about the writing-based and sound-based 
input modes. See Chapter 3 for instructions on how to use the Traditional Chinese Input 
Method and its input modes. See Chapter 4 for instructions on how to use the Simplified
Chinese Input Method and its input modes.
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Writing-Based Input Systems

Simplified Chinese uses over 6,000 characters, while Traditional Chinese uses over 16,000 
characters. These characters are used individually as words. In addition, two or three 
characters can be combined to form a phrase, which represents a word.

Chinese characters have three levels: strokes used to draw the characters; combinations of 
strokes which form simple graphic elements, called radicals, that make up the characters; 
and the whole character.
Note: The word radical is also used to designate the root of a character.

Writing-based input modes are either stroke-based or radical-based:
m A stroke-based input system defines the basic strokes used to write Chinese characters 

and assigns the strokes to keys on the Roman-based keyboard.
m A radical-based input system defines the radicals used to write Chinese characters and 

assigns the radicals to keys on the Roman-based keyboard.

To enter a character, you type the keys for the strokes or radicals in the order specified by the 
input mode to compose the characters. This order is based on the way Chinese characters 
are written. To use a stroke or radical input system, you must know how to write Chinese, as 
well as understand how the input mode works.

Stroke and radical input modes are popular with Chinese speakers because they are based on 
writing the characters. They allow you to enter Chinese characters rapidly and without 
converting them to a foreign writing system, as the Pinyin input mode does.

Because these input modes define a limited number of strokes or radicals, they do not 
include all the elements used in Chinese characters. In addition, it may not be clear which 
stroke or radical to use for a character in some cases.

These input modes limit the number of strokes or radicals you can use to designate a 
character. The limit can be less than the number of elements actually used to write the 
character. For example, the Wubi Hua input mode, which is a stroke input system, allows up 
to five strokes for a character, but many Chinese characters require more than five strokes.

Because of these limitations, you may have to select the character you want from several 
alternatives after you type the keys for the strokes or radicals that make up the character.
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Sound-Based Input Systems

Sound-based, or phonetic, input modes allow you to write the Chinese characters based on 
how characters sound in Mandarin Chinese. There are two types: 
m Typing specific keys for Chinese phonetic symbols (bo po mo fo)

To use the Chinese phonetic symbols effectively, you need to know how to speak Chinese 
characters and transcribe them into the phonetic symbols.

m Typing Roman characters to spell the Chinese characters using the Pinyin phonetic 
transcription system
Pinyin is popular with users who do not know how to write Chinese characters and may 
have limited knowledge of how to pronounce Chinese words.
Because Chinese words are distinguished by subtle tonal variations that are difficult to 
transcribe phonetically, many different Chinese characters have the same phonetic 
spelling in Pinyin. When you enter the Pinyin for a Chinese character, the input system 
often identifies many characters with that spelling and you must choose the character you 
want. For example, 34 Traditional Chinese characters are transcribed in Pinyin as “ren” and 
appear as alternatives if you enter these Roman characters.
Note: The Traditional Chinese Pinyin input mode allows you to enter a number for the 
tonal variation to narrow the list of alternatives.
Although entering Chinese using Pinyin requires several steps, it allows people who are 
not fluent in writing the language to create a Chinese-language document.

Other Features of the Chinese Language Kit

In addition to allowing you to enter Chinese characters, both the Traditional Chinese and 
Simplified Chinese input methods provide other important features:
m an input mode that allows you to type Roman characters
m an input mode for entering AppleShare passwords
m a dictionary in which you can define your own words and phrases
m palettes for looking up the input keys for characters, punctuation, and symbols
m an option to show the key combinations to enter characters in the selection palette
m an option to display other characters frequently associated with a character you enter
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Other Chinese Language Kit Software

The Chinese Language Kit includes other software to help you work with the input methods. 

The Chinese Language Kit Fonts

The Chinese Language Kit provides fonts for Traditional Chinese and Simplified Chinese. 
These fonts contain the Chinese characters that you will see in your documents on screen 
and when you print them.
Note: The Chinese fonts include some Roman characters as one-byte and two-byte 
characters.

The Traditional Chinese fonts are
m Taipei, a bitmap font
m Apple LiSung Light, a printing-style TrueType font
m Apple LiGothic Medium, a bold TrueType font
m BiauKai, a brushstroke-style TrueType font

The Simplified Chinese fonts are
m Beijing, a bitmap font
m Song, a printing-style TrueType font
m Fang Song, a handwriting-style TrueType font
m Hei, a bold-style TrueType font
m Kai, a brushstroke-style TrueType font

The Localized SimpleText Programs

The Chinese Language Kit includes two localized versions of Apple’s SimpleText application:
m Traditional Chinese SimpleText, localized with Traditional Chinese characters
m Simplified Chinese SimpleText, localized with Simplified Chinese characters

These programs allow you to write basic text documents. You can use them while you’re
learning to use the Chinese Language Kit input methods.
Note: You can use any application that supports the WorldScript II technology with the 
Chinese Language Kit. The program does not need to be localized into Chinese.
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The Language Register Program

Some programs are localized to display menus, dialog boxes, help balloons, and other items 
in Chinese characters. However, if a program does not indicate to the system the language 
and font to use to display these items, you will not see the localized version with the Chinese 
Language Kit installed.
Note: You will see the localized version of the application if you have a version of the Mac 
OS localized in Chinese installed on your computer.

The Language Register provided with the Chinese Language Kit lets you register these 
programs so that they display menus and other items in Chinese characters. To learn how to 
use the Language Register, see “Choosing a Language for an Application Program” on page 20 
in Chapter 2.

Chinese Utility Applications

The Chinese Language Kit includes several applications in the Chinese Utilities folder (in the 
Apple Extras folders). 

The Traditional Chinese Dictionary Tool (filename “Trad. Chinese DicTool”) application is also 
provided with the Chinese Language Kit and it continues to be used as the dictionary for the 
Traditional Chinese Input Method. It’s in the Extensions folder.

Program Description

TrueType Font Editor Lets you create your own TrueType Chinese characters that you 
can use in your documents

Input Method Plug-in Converter Lets you convert a text file that specifies an input method plug-
in so that it can be used with the input method. Plug-ins can 
add input modes and other features to the input method.

Sample (SC) and Sample (TC) Example plug-ins you can use to learn how to write one

Simplified Chinese 
Dictionary Tool
(filename “Simp. Chinese 
DicTool”)

Lets you create and edit dictionaries that you can use with the 
Simplified Chinese Input Method
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What Are Scripts?

The input methods of the Chinese Language Kit are based on Apple’s WorldScript 
technology. With WorldScript software known as script systems installed on your computer, 
you can work with different languages and the writing systems they use.

A script system tells your computer a number of things, such as
m the characters the script contains and the keystrokes that produce each character
m the direction in which text flows (left to right or right to left)
m how to sort words
m how to separate words and lines of text
m how to format dates, times, numbers, and currency

The script used by your system software is your computer’s primary script. It determines 
the characters used in the menus, dialog boxes, and other items on your computer screen, 
and the formats used for dates, times, numbers, and currency.

For example, if you’re working in English, then the Roman script is your primary script. This 
means that the Roman character set is available to you and that text flows from left to right as 
you type characters.

If you install a language kit that uses a different script, that script becomes a secondary script
for your system. For example, when you install the Chinese Language Kit on a computer 
using the Roman script as the primary script, Chinese is the secondary script.

The same script can be used by several languages, if they share most of the same characters. 
Following are some examples of scripts and some of the languages they support:
m Roman—French, Italian, Spanish, English, and German
m Arabic—Arabic and Persian
m Cyrillic—Russian, Ukrainian, Byelorussian, and Bulgarian
m Hebrew—Hebrew, Yiddish
m Indian—Devanagari (Sanskrit, Hindi, Marathi, and Nepali), Gujarati, and Gurmukhi 

(Punjabi)
m Japanese
m Korean
m Thai

The Chinese Language Kit provides two scripts:  Traditional Chinese and Simplified Chinese. 
Each of these scripts defines a keyboard-based input method. You can install either script, or 
both, on your computer. 
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2
2 Installing and Setting Up the Software

This chapter describes the system requirements for using the Chinese Language Kit and 
explains how to install the software on a computer. It also explains how to
m choose a keyboard layout or input method from the Keyboard menu
m use Chinese characters for file and folder names in the Finder
m select the behavior for the Traditional Chinese Input Method using the Text control panel
m register an application that is localized for Chinese using the Language Register program

System Requirements

To use the Chinese Language Kit, you need the following hardware and software:

Item Requirement

Computer Mac OS–based with a 68030, 68040, or PowerPC™ microprocessor

RAM At least 12 megabytes (MB) of actual RAM

Disk space (free)1 Using Easy Install requires up to 40 MB.2

Using Custom Install to install 
m the minimum Traditional Chinese Input Method requires 6 MB
m the minimum Simplified Chinese Input Method requires 4 MB
m the complete Traditional Chinese Input Method requires 42 MB
m the complete Simplified Chinese Input Method requires 37 MB
m the TrueType Font Editor application requires 17 kilobytes (K)

System software Version 7.6 or later

1 When you are installing the software, the amount of disk space required may be greater than the amount shown here because 
the Installer program temporarily saves files it is replacing.

2 The amount of disk space required may be less than 40 MB depending on the version of system software installed on your 
computer and the size of your hard disk.
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Installing the Software

You install the Chinese Language Kit software using the Installer program located on the 
Chinese Language Kit CD-ROM disc.
Note: You can install the Chinese Language Kit on a computer with a localized version of 
system software. If the computer has the Traditional Chinese Mac OS installed on it, you 
cannot install the Traditional Chinese Input Method or the Traditional Chinese fonts on the 
computer. If it has the Simplified Chinese Mac OS installed, you cannot install the Simplified
Chinese Input Method or the Simplified Chinese fonts on the computer.

To install the Chinese Language Kit software, follow these steps:

1 Insert the Chinese Language Kit CD-ROM disc in your CD-ROM disc drive.

2 Double-click the Installer icon.

3 Click Continue when the Installer dialog box appears. 

4 Read the License Agreement that appears, then click Agree to continue.

The Installer dialog box appears.

5 To install the basic software of the Chinese Language Kit, leave Easy Install selected.

Easy Install installs the Simplified Chinese Input Method, the Traditional Chinese Input 
Method, three Simplified Chinese fonts, and three Traditional Chinese fonts.

If you know exactly which parts of the software you want to install, choose Custom Install 
from the pop-up menu and select the software you want to install.

If an item has a triangle next to it, you can click the triangle to see the individual items that 
are installed if you select the main item. You can select the main item to install all the items 
under it, or you can select individual items to install.

6 Make sure that the Destination Disk shows the hard disk on which you want to install the 
software.

If the destination disk isn’t correct, click Switch Disk until the correct disk appears.

7 When you are ready, click Install.

8 Follow the directions that appear onscreen.

9 If a message appears telling you that you need to restart your computer, click Restart.

Warning  If you install only the input method fonts, you will not be able to use the fonts, 
and your system may not work properly.
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Where the Files Are Located

The Chinese Language Kit installs files on the hard disk, in the Mac OS Read Me folder, in the 
Apple Extras folder, and in the Extensions folder and Fonts folder in the System Folder.
Note: The files installed in the Extensions folder depend on the system software you are 
using. The following tables do not include these files.

The Read Me file is installed in the Mac OS Read folder (on your hard disk.)

The Traditional Chinese Input Method uses these files:

The Simplified Chinese Input Method uses these files:

You can use Custom Install to install the TrueType Font Editor program. If you do, it’s in the 
Chinese Utilities folder.

Item Location

Fonts:  Taipei, Apple LiSung, Apple LiGothic1 Fonts folder (in the System Folder)

Traditional Chinese SimpleText program Hard disk

Language Register program
Key Caps program2

Chinese Utilities folder

Apple Extras folder (on your hard disk)

Input Method Plug-in Converter program
Sample (TC)

Chinese Utilities folder (in the Apple Extras folder)

1 You can use Custom Install to install the BiauKai font.
2 Key Caps is installed in the Apple Menu Items folder (in the System Folder) if an older version is already in the folder. 

Item Location

Fonts:  Beijing, Kai, Song1 Fonts folder
(in the System Folder)

Simplified Chinese SimpleText program Hard disk

Language Register program
Key Caps program2

Chinese Utilities folder

Apple Extras folder
(on your hard disk)

Input Method Plug-in Converter program
Sample (SC)

Chinese Utilities folder (in the Apple Extras folder)

1 You can use Custom Install to install the Fang Song and Hei fonts.
2 Key Caps is installed in the Apple Menu Items folder (in the System Folder) if an older version is already in the folder. 
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Using the Keyboard Menu

After you install the Chinese Language Kit and restart your computer, the Keyboard menu 
icon appears at the right end of the menu bar.

You use the Keyboard menu to select the keyboard layout or input method you want to use. 
The Keyboard menu has a section for each script installed on your computer. The section for 
the primary script of your system software appears at the top of the menu. If the primary 
script of your system software is the Roman script, then the first section of the menu lists the 
keyboard layouts available for Roman-based languages. After you install the Chinese 
Language Kit, a section appears at the bottom of the menu for each script you installed.

If the primary script of your system software is either the Traditional Chinese or Simplified
Chinese script, then the section for that script appears at the top of the Keyboard menu. The 
section for the other script appears at the bottom of the menu.

To select a keyboard layout or an input method, do one of the following:
m Choose the item from the menu.
m Type x–Option–Space bar to select the next item in the same section of the menu, if you 

select the option in the Keyboard control panel. 
m Type x–Space bar to select an item in the next section of the Keyboard menu.

When you choose a keyboard layout or input method, the icon for the Keyboard menu 
changes to show the current selection.

Displaying Finder Names in Chinese

After you install the Chinese Language Kit, you can display file and folder names in the Finder 
with Chinese characters. To do this, you must change the font used in the Finder. How you 
do this depends on the version of the system software you are using.

If you are using system software prior to version 8.0:

1 Choose Control Panels from the Apple (K) menu and open the Views control panel.

2 Choose the font you want to use from the “Font for views” pop-up menu.
m To use Traditional Chinese characters, choose Taipei or another Traditional Chinese font.
m To use Simplified Chinese characters, choose Beijing or another Simplified Chinese font.

Keyboard menu icon
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3 Change the size of the font to 9 or 12 point.

4 Close the control panel.

If you are using system software version 8.0 or later:

1 In the Finder, choose Preferences from the Edit menu.

2 Choose the font you want to use from the “Font for views” pop-up menu.
m To use Traditional Chinese characters, choose Taipei or another Traditional Chinese font.
m To use Simplified Chinese characters, choose Beijing or another Simplified Chinese font.

3 Change the size of the font to 9 or 12 point.

4 Close the Preferences window.

Because the Chinese fonts contain the most common Roman characters, file and folder 
names in Roman characters will continue to be displayed correctly.

Changing Sorting Order With the Text Control Panel

You can use the Text control panel to change the behavior of a script. This affects
m the order in which text is sorted
m how uppercase and lowercase characters are converted
m how words are separated from one another

The Simplified Chinese Input Method provides only one sorting order. The Traditional 
Chinese Input Method provides three sorting orders. To change the sorting order for 
Traditional Chinese, follow these steps:

1 Choose Control Panels from the Apple (K) menu and open the Text control panel.

2 Choose Traditional Chinese from the Script pop-up menu.

3 Choose the behavior you want to use from the Behavior pop-up menu.

4 Close the Text control panel.

Important  If the primary script of your system software is non-Roman (for example, 
Japanese or Korean) or you use special characters (such as é) in file and folder names, those 
file and folder names will not be displayed correctly.

Choose this: To sort by this:

Code-order sort The Big5 Code code number

Radical-stroke sort Radicals first, then strokes

Stroke-radical sort Strokes first, then radicals
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Choosing a Language for an Application Program

If you open a program localized in Chinese and it does not display menus, dialog boxes, 
Balloon Help, and other items in Chinese characters, you should register the program using 
the Language Register application.

To register a program localized in Chinese, follow these steps:

1 Open the Language Register program in the Apple Extras folder.

The Language Register dialog box appears.

2 Choose the language to register the program with from the Language pop-up menu: 
Traditional Chinese or Simplified Chinese.

3 Click Register.

4 In the dialog box that appears, locate and select the application you want to register.

5 Click Register.

6 Click OK in the dialog box that appears.

7 Click OK in the Language Register dialog box to make Traditional Chinese or Simplified
Chinese the default language used by the Language Register application and to close the 
application.

Click Cancel to close the application without changing the default language.

To register a program in the default language, drag the program to the Language Register 
application. You can make copies of the Language Register application with different default 
languages selected to register programs.

You can register a program with only one language. If you decide to register a program with a 
different language after you have registered it with Traditional Chinese or Simplified Chinese, 
follow this procedure and choose the language in step 2.

If you change the name of a program after you register it, it will no longer be registered.

Converting Plug-ins

Plug-ins provide additional features and capabilities to the input methods. To create a plug-in 
you specify what the plug-in does using a text file. See the “Sample (SC)” or the “Sample
(TC)” text files in the Chinese Utilities folder for an example of an input method plug-in.

When you have created the plug-in text file, you need to convert it using the Input Method 
Plug-in Converter program so that you can use it with the input method.
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To convert a plug-in, follow these steps:

1 Locate and open the Input Method Plug-in Converter.

It is in the Chinese Utilities folder in the Apple Extras folder.

2 Choose Open from the File menu.

3 In the dialog box that appears, locate the text file for the plug-in and open it.

After you convert a plug-in, place it in the Input Method Plug-in folder, which is in the 
Extensions folder (in the System Folder) on your hard disk and restart your computer. If 
there isn’t an Input Method Plug-in folder in the Extensions folder, create one.

Removing the Chinese Language Kit

If you decide you want to remove the Chinese Language Kit software, you use the same 
Installer program you used to install the software.

To remove the Chinese Language Kit software, follow these steps:

1 Insert the Chinese Language Kit CD-ROM disc in the CD-ROM disc drive.

2 Double-click the Installer icon.

3 Click Continue when the Installer dialog box appears.

4 Click Agree when the License Agreement dialog box appears.

The Installer dialog box appears.

5 Choose Custom Remove from the pop-up menu.

6 Click to select the software you want to remove.

7 Make sure that the Destination Disk is the hard disk from which you want to remove the 
Chinese Language Kit.

If the destination disk isn’t correct, click Switch Disk until the correct disk is shown.

8 When you are ready, click Remove.

9 Follow any directions that appear onscreen.

10 When the Installer finishes, you may need to restart your computer.

Warning  If you remove the “Minimum Simplified Chinese and Beijing Font” or the 
“Minimum Traditional Chinese and Taipei Font” option and you do not remove the other 
input method fonts, you will not be able to use the fonts and your system software may 
not work properly.
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3
3 Using the Traditional Chinese 

Input Method
What Is the Traditional Chinese Input Method?

The Traditional Chinese Input Method allows you to enter traditional-style Chinese 
characters, punctuation, and symbols. The Traditional Chinese Input Method includes over 
13,000 traditional Chinese characters, which you can enter using one of several input modes.

The Traditional Chinese Input Method provides six input modes for entering Chinese 
characters and the Password input mode for entering AppleShare passwords. In addition, the 
input method allows you to
m open palettes for looking up and entering characters, punctuation marks, and symbols
m use dictionaries created with the Traditional Chinese Dictionary Tool, create new 

dictionaries, and add your own phrases to a dictionary
m display the key combinations to enter characters in the character selection palette
m display characters frequently associated with a character you enter

This chapter describes how to use each input mode and the other features of the Traditional 
Chinese Input Method.

Starting to Use the Traditional Chinese Input Method

To begin to use the Traditional Chinese Input Method, follow the steps in this section.
Before you start:  You may want to open an application, such as Traditional Chinese 
SimpleText, so that you can enter Chinese characters while learning to use the input method.
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Step 1: Choose the Traditional Chinese Input Method

All input methods installed on your computer, including those of the Chinese Language Kit, 
appear in the Keyboard menu at the right side of the menu bar.

If the primary script on your computer is the Roman script, the Keyboard menu shows 
keyboard layouts at the top. The Chinese Language Kit input methods are near the bottom. If 
the primary script of your system software is the Traditional Chinese script, then the input 
methods appear at the top of the menu.

To use the Traditional Chinese Input Method, perform this step:
m Choose the Traditional Chinese Input Method from the Keyboard menu.

The Pencil menu appears in the menu bar.

Traditional Chinese
Input Method

Keyboard menu

Keyboard layouts
(Layouts available on your 
computer may be different.)

Input modes Input modes

Pencil menuPencil menu

Choose here to view 
the menu in Chinese.

Choose here to view
the menu in English.
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You use the Pencil menu to choose the input mode and other options you want to use for 
the Traditional Chinese Input Method. Some commands are available only in certain input 
modes.

When the Pencil menu appears, the operation palette also appears. The operation palette lets 
you perform some of the same tasks that you perform by choosing commands from the 
Pencil menu.

Step 2: Choose an Input Mode

To choose the input mode you want to use, you can choose it from the Pencil menu, press 
the keys shown next to the input mode in the Pencil menu, or choose it from the pop-up 
menu in the operation palette.

Step 3: Choose Other Options and Preferences

After you choose an input mode, you may want to select other options or select preferences 
using the Preferences dialog box. Some options affect the behavior of all the input modes, 
while others are only available for certain input modes. See the next section, “Entering and 
Editing Characters,” to learn about the options you can select for each input mode.

Step 4: Enter the Character

How you enter characters depends on the input mode you are using. See the next section, 
“Entering and Editing Characters,” to learn how to enter characters using each of the input 
modes.

As you enter characters, you may see one or more palettes:
m The input palette appears if the application or dialog box where you are entering 

characters does not allow you to enter characters directly into a document or text box. 
(See “Using the Input Palette and Inline Input” on page 44.)

m The selection palette appears if the input mode matches more than one Chinese 
character with the keys you press. You can select and enter a character from the palette. 
(See “Using the Selection Palette” on page 45.)
If you choose Show Input Keys from the Pencil menu, you see the keys for entering 
characters in the selection palette.

Important  When the Pencil menu appears, it is in Chinese. If you want to see the menu 
items in English, choose Show English Menu from the menu.

Choose an input mode here.
Click here to see the Preferences dialog box.
Click here to open the Traditional Chinese Dictionary Tool application.
Click here to see the Character table.
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Entering and Editing Characters

The Traditional Chinese Input Method provides the following input modes. 

The following sections describe how to use each of the input modes provided with the 
Traditional Chinese Input Method.

Entering Chinese Characters Using the Cangjie Input Mode

The Cangjie input mode is a writing-based input mode. To use the Cangjie input mode, you 
need to know how to write Chinese characters using the radicals and the rules defined by the 
input mode for composing Chinese characters.

Input mode Method for entering characters

Cangjie Press keys for the radicals defined by the input mode to write 
the character.

Jianyi (simple Cangjie) Press keys for the first and last radicals defined by the Cangjie 
input mode to write the character.

Dayi Press keys for the radicals defined by the input mode to write 
the character.

Pinyin Press Roman keys to spell the character phonetically using the 
Pinyin transcription system.

Zhuyin Press keys for Chinese symbols (bo po mo fo) to spell the 
character phonetically.

Big5 Code Type a hexadecimal code for the character.

Password Type an AppleShare password.1

1 If your AppleShare password is not accepted and you are sure you have typed the password correctly, choose this input mode 
before you enter the password again.

Important  This manual explains how to use Cangjie with the Chinese Language Kit, but 
does not explain how to use the Cangjie radicals. Several books are available in Chinese that 
describe how to use Cangjie.
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Cangjie defines 24 radicals that you combine to specify characters. Each radical is assigned to 
a key on the main keyboard.

To enter a character using the Cangjie input mode, follow these steps:

1 Choose Cangjie from the Pencil menu.

2 Select the options you want to use:

Q W E R T Y U I O P
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If you want to Do this:

See the selection palette as soon 
as you begin entering radicals

Choose Preferences from the Pencil menu and select the Use 
Dynamic Search option. (See “Selecting General Preferences”
on page 48.)

See the keys to enter characters 
in the selection palette

Choose Show Input Keys from the Pencil menu.

See suggestions for subsequent 
characters to enter

Choose Show Associated Words from the Pencil menu.
The selection palette appears after you enter a character 
showing characters that commonly follow the one you entered.

Keep the input palette open 
while entering characters

Choose Preferences from the Pencil menu and select the Keep 
Input Palette Open option. (See “Selecting General 
Preferences” on page 48.)

Keep characters in the input 
palette

Choose Store Characters from the Pencil menu.

Use dictionary files Choose Preferences from the Pencil menu and select the 
dictionary files to use. (See “Selecting Dictionary Preferences”
on page 50.)
The input keys for phrases in the dictionary use the Dayi input 
mode. To enter a phrase from the dictionary using Cangjie, 
choose Show Associated Words from the Pencil menu; then 
enter the first character in the phrase using Cangjie. The 
selection palette shows the phrase for you to select.
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3 Press the keys for the radicals to enter the character.

You can use up to five keys to enter a character. The first two keys define the left or top 
component of the character, and the remaining keys define the other components of the 
character.

If you don’t know which radical to use, press z.

The input palette appears if the application you are using does not allow you to enter 
characters directly into a document. (See “Using the Input Palette and Inline Input” on 
page 44.)

4 Do one of the following:
m Press Return to enter the character.

The Cangjie input mode searches for the first character that matches the one you 
entered.

m Press the Space bar. 
The Cangjie input mode searches for the first character that matches the one you 
entered. If you entered the wildcard character (z), you see the selection palette.

m Press Enter to enter the radicals without converting them to a character.

5 If the selection palette appears, find the character you want to enter and click it to enter it in 
the document or input palette. (See “Using the Selection Palette” on page 45.)

6 If you are using the input palette, press Return or Enter to enter the character.

For example, press the following keys to enter the characters for “Apple Computer”:

English
word

Chinese 
character Pinyin

Cangjie
keys

Cangjie
radicals

Apple ping tyhc

guo wd

Computer dian mbwu

nao bvvw
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Entering Chinese Characters Using the Jianyi Input Mode

The Jianyi input mode is a simplified form of Cangjie. It uses the same radicals as Cangjie. 
Using Jianyi to enter a character, you press the key for the first and last radicals that you 
would enter using Cangjie, unless you can specify the character with a single key.

Because you enter fewer keys to specify a character, the Jianyi input mode finds more 
characters that match what you have entered, so the selection palette appears more 
frequently.

To enter a character using the Jianyi input mode, follow these steps:

1 Choose Jianyi from the Pencil menu.

2 Select the options you want to use:

Important  This manual explains how to use Jianyi with the Chinese Language Kit, but does 
not explain how to use the Jianyi radicals. Several books are available in Chinese that describe 
how to use Jianyi.

If you want to Do this:

See the selection palette as soon 
as you begin entering radicals

Choose Preferences from the Pencil menu and select the Use 
Dynamic Search option. (See “Selecting General Preferences”
on page 48.)

See the keys to enter characters 
in the selection palette

Choose Show Input Keys from the Pencil menu.

See suggestions for subsequent 
characters to enter

Choose Show Associated Words from the Pencil menu.
The selection palette appears after you enter a character 
showing characters that commonly follow the one you entered.

Keep the input palette open 
while entering characters

Choose Preferences from the Pencil menu and select the Keep 
Input Palette Open option. (See “Selecting General 
Preferences” on page 48.)

Keep characters in the input 
palette

Choose Store Characters from the Pencil menu.

Use dictionary files Choose Preferences from the Pencil menu and select the 
dictionary files to use. (See “Selecting Dictionary Preferences”
on page 50.)
The input keys for phrases in the dictionary use the Dayi input 
mode. To enter a phrase from the dictionary using Jianyi, 
choose Show Associated Words from the Pencil menu; then 
enter the first character in the phrase using Jianyi. The selection 
palette shows the phrase for you to select.
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3 Press the keys for the radicals to enter the character.

Unless you can specify the character with a single key, press the key for the first and last 
radical that specifies the character.

The input palette will appear if the application you are using does not allow you to enter 
characters directly into a document. (See “Using the Input Palette and Inline Input” on 
page 44.)

4 Do one of the following:
m Press Return to enter the character.

The Jianyi input mode enters the character specified by the radicals that is most 
frequently used.

m Press the Space bar to see the selection palette.
m Press Enter to enter the radicals without converting them to a character.

5 If the selection palette appears, find the character you want to enter and click it to enter it in 
the document or input palette. (See “Using the Selection Palette” on page 45.)

6 If you are using the input palette, press Return or Enter to enter the character.

For example, press the following keys to enter the characters for “Apple Computer”:

English
word

Chinese
character Pinyin

Jianyi
keys

Jianyi
radicals

Apple ping tc

guo wd

Computer dian mu

nao bw
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Because the Cangjie input mode requires only one or two keys to specify some characters, 
you may use the same keys when using Jianyi. Following are some examples of the keys you 
would type in Cangjie and Jianyi for several characters.

Entering Chinese Characters Using the Dayi Input Mode

The Dayi input mode uses 40 radicals that it defines and the 214 Kangxi character radicals 
used in Traditional Chinese. To use the Dayi input mode, you need to know how to write 
Chinese characters using these radicals and the rules defined by the input mode for 
composing Chinese characters. 

To enter a character, you type up to four radicals. The order in which you type the radicals to 
enter a character is determined by the way in which the character is written and the 
components that make up a character. Follow these rules:

Chinese 
character

Cangjie 
keys

Cangjie 
radicals

Jianyi 
keys

Jianyi 
radicals

l l

yk yk

hvif hf

vfyiu vu

Important  This manual explains how to use Dayi with the Chinese Language Kit, but does 
not explain how to use the Dayi radicals. Several books are available in Chinese that describe 
how to use Dayi.

=1 2 3 4 5 6 7 8 9 0 -
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1 Enter radicals for the component of the character that contains the most strokes. Enter 
the radicals for the first radical, second radical, third radical, and last radical. If the same 
radical appears twice in this sequence only enter it once.

2 You can use a single radical for a component of a character that consists of several strokes. 
Although this may mean some of the strokes of the component are not entered in the 
correct order, it reduces the number of radicals required to define the character.

3 Some Chinese characters have a central component with other components on the left 
and right side. If the components on the sides are symmetrical, enter the radicals for the 
central component first, then the outside components. If they are not symmetrical, enter 
the radicals from left to right.

4 If the inner component is completely surrounded by other strokes, enter the radicals for 
the outside strokes first, then the inner component.

5 If the inner component of a character is surrounded by other strokes but there is an 
opening in the surrounding strokes, follow these rules:
a If the opening is to the left, right, or bottom of the inner component, then enter the 

radicals for the outside strokes first.
b If the opening is at the top, then enter the radicals for the inner component first.
c If the surrounding strokes are open on two sides with a radical on the upper-left or 

upper-right, then enter the radicals for the outside strokes first.
d If the surrounding strokes are open on two sides with a radical on the bottom-left or 

bottom-right of the inner component, then enter the radicals for the inner component 
first.

e Otherwise, if the inner strokes do not form a radical, then enter the radicals for the 
strokes from left to right and top to bottom.

The following table provides examples of these five rules.

Rule
Chinese 
character

Cangjie 
key

Dayi 
radicals

a r5

b xw

c bo

d fok0

e q;;o
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6 If you write a component that corresponds to a Dayi radical and then write other strokes 
that cross over it, enter the Dayi radical first.

7 To enter a phrase consisting of two or three characters, follow these rules:
m If the phrase consists of two characters, enter the first and last radical for each 

character.
m If the phrase consists of three or more characters, enter the first radical for the first,

second, and third characters, and the last radical for the last character in the phrase.

To enter a character using the Dayi input mode, follow these steps:

1 Choose Dayi from the Pencil menu.

2 Select the options you want to use:

3 Press the keys for the radicals to enter the character.

Press up to four keys to specify the character.

The input palette appears if the application you are using does not allow you to enter 
characters directly into a document. (See “Using the Input Palette and Inline Input” on 
page 44.)

4 Do one of the following:
m Press Return to enter the character.
m Press the Space bar to see the selection palette.
m Press Enter to enter the radicals without converting them to a character.

If you want to Do this:

See the keys to enter characters 
in the selection palette

Choose Show Input Keys from the Pencil menu.

See suggestions for subsequent 
characters to enter

Choose Show Associated Words from the Pencil menu.
The selection palette appears after you enter a character 
showing characters that commonly follow the one you entered.

Keep the input palette open 
while entering characters

Choose Preferences from the Pencil menu and select the Keep 
Input Palette Open option. (See “Selecting General 
Preferences” on page 48.)

Keep characters in the input 
palette

Choose Store Characters from the Pencil menu.

Use dictionary files Choose Preferences from the Pencil menu and select the 
dictionary files to use. (See “Selecting Dictionary Preferences”
on page 50.)
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5 If the selection palette appears, find the character you want to enter and click it to enter it in 
the document or input palette. (See “Using the Selection Palette” on page 45.)

6 If you are using the input palette, press Return or Enter to enter the character.

For example, press the following keys to enter the characters for “Apple Computer”:

Entering Chinese Characters Using the Pinyin Input Mode

Using the Pinyin input mode, you enter Chinese characters by typing Roman characters to 
spell the character phonetically based on Mandarin Chinese. The phonetic spelling is based 
on the Pinyin phonetic transcription of the character. (See the Appendix, “Phonetic
Transcription Systems for Chinese,” on page 97 for a table of the phonetic transcription 
systems.)

In addition, you can type a number from 1 to 5 on the numeric keypad to enter the tone of 
the character. Doing so reduces the number of characters that appear in the selection 
palette. The table lists the numeric keypad keys and the tone each indicates.

English
word

Chinese
character Pinyin

Dayi 
keys

Dayi 
radicals

Apple ping u9t8

guo di

Computer dian mdc

nao jl/n

Numeric key Tone

1 Level tone

2 Rising tone

3 Dipping tone

4 Falling tone

5 Neutral tone
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To enter Chinese characters using the Pinyin input mode, follow these steps:

1 Choose Pinyin from the Pencil menu.

2 Select the options you want to use:

3 Press the keys for the Roman characters that spell the character phonetically using the Pinyin 
transcription system.

The input palette appears if the application you are using does not let you enter characters 
directly into a document. (See “Using the Input Palette and Inline Input” on page 44.)

4 Press the Space bar or Return.

Press Enter to enter the Pinyin characters without converting them to a Chinese character.

If you want to Do this:

See the selection palette as soon 
as you begin pressing keys

Choose Preferences from the Pencil menu and select the Use 
Dynamic Search option. (See “Selecting General Preferences”
on page 48.)

Enter characters using 
Simplified Pinyin

Choose Preferences from the Pencil menu and select the Use 
Simplified Pinyin option. (See “Using Simplified Pinyin” on 
page 36 and “Selecting General Preferences” on page 48.)

See the keys to enter characters 
in the selection palette

Choose Show Input Keys from the Pencil menu.

See suggestions for subsequent 
characters to enter

Choose Show Associated Words from the Pencil menu.
The selection palette appears after you enter a character 
showing characters that commonly follow the one you entered.

Keep the input palette open 
while entering characters

Choose Preferences from the Pencil menu and select the Keep 
Input Palette Open option. (See “Selecting General 
Preferences” on page 48.)

Keep characters in the input 
palette

Choose Store Characters from the Pencil menu.

Use dictionary files Choose Preferences from the Pencil menu and select the 
dictionary files to use. (See “Selecting Dictionary Preferences”
on page 50.)
The input keys for phrases in the dictionary use the Dayi input 
mode. To enter a phrase from the dictionary using Pinyin, 
choose Show Associated Words from the Pencil menu; then 
enter the first character in the phrase using Pinyin. The 
selection palette shows the phrase for you to select.
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5 In the selection palette, find the character you want to enter and click it to enter it in the 
document or input palette. (See “Using the Selection Palette” on page 45.)

6 If you are using the input palette, press Return or Enter to enter the character.

For example, press the following keys to enter the characters for “Apple Computer”:

Using Simplified Pinyin

The Pinyin input mode lets you use Simplified Pinyin to enter common sound combinations 
by pressing a single key. To use this feature, first select the Use Simplified Pinyin option in 
the Preferences dialog box. (See “Selecting General Preferences” on page 48.)

To enter a character, press keys to spell the character phonetically using the standard Pinyin 
system, but press single keys for the sound combinations shown in the table.

English
word

Chinese
character Pinyin Tone

Apple ping 2

guo 3

Computer dian 4

nao 3

To enter this sound: Press this key:

ch i

sh u

zh a

ai l

an j

ang h

ao k

en f

eng g

ing y

ong s

ü v
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Note: As you press keys for Simplified Pinyin, you see the standard Roman character for the 
key. However, the input mode uses the Simplified Pinyin to select the character.

For example, press the following keys to enter the characters for “Apple Computer”:

Entering Chinese Characters Using the Zhuyin Input Mode

The Zhuyin input mode uses the Chinese phonetic symbols (bo po mo fo) to spell the 
character in Mandarin Chinese. Each symbol is assigned to a key.

English
word

Chinese
character

Simplified 
Pinyin Tone

Apple py 2

guo 3

Computer dij 4

nk 3

=1 2 3 4 5 6 7 8 9 0 -
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To enter a Chinese character using the Zhuyin input mode, follow these steps:

1 Choose Zhuyin from the Pencil menu.

2 Select the options you want to use:

3 Press the keys for the Zhuyin phonetic symbols that spell the Chinese character phonetically 
in Mandarin Chinese.

The input palette appears if the application you are using does not allow you to enter 
characters directly into a document. (See “Using the Input Palette and Inline Input” on 
page 44.)

4 Do one of the following:
m Press Return to enter the character if you are sure that the first character the input mode 

will select is the one you want to enter.
m Press the Space bar to see the selection palette.

If you want to Do this:

See the selection palette as soon 
as you begin entering radicals

Choose Preferences from the Pencil menu and select the Use 
Dynamic Search option. (See “Selecting General Preferences”
on page 48.)

See the keys to enter characters 
in the selection palette

Choose Show Input Keys from the Pencil menu.

see suggestions for subsequent 
characters to enter

Choose Show Associated Words from the Pencil menu.
The selection palette appears after you enter a character 
showing characters that commonly follow the one you entered.

Keep the input palette open 
while entering characters

Choose Preferences from the Pencil menu and select the Keep 
Input Palette Open option. (See “Selecting General 
Preferences” on page 48.)

Keep characters in the input 
palette

Choose Store Characters from the Pencil menu.

Use dictionary files Choose Preferences from the Pencil menu and select the 
dictionary files to use. (See “Selecting Dictionary Preferences”
on page 50.)
The input keys for phrases in the dictionary use the Dayi input 
mode. To enter a phrase from the dictionary using Zhuyin, 
choose Show Associated Words from the Pencil menu; then 
enter the first character in the phrase using Zhuyin. The 
selection palette shows the phrase for you to select.
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5 In the selection palette, find the character you want to enter and click it to enter it in the 
document or input palette. (See “Using the Selection Palette” on page 45.)

6 If you are using the input palette, press Return or Enter to enter the character.

For example, press the following keys to enter the characters for “Apple Computer”:

Entering Chinese Characters Using the Big5 Code Input Mode

The Big5 Code input mode allows you to enter Chinese characters by typing a 4-digit 
hexadecimal code for each character. To use this input mode, you must know the 
hexadecimal code for the character. You can use the Character table to look for characters 
and see their codes. (See “Using the Character Table” on page 46 later in this chapter.)
Note: Hexadecimal codes are base-16 numbers. Hexadecimal numerals include the usual 
numerals 0–9 and the letters a–f for the numerals 10–15.

To enter Chinese characters using the Big5 Code input mode, follow these steps:

1 Choose Big5 Code from the Pencil menu.

2 Type the 4-digit code for the character you want to enter.
Note: You can type numerals using the number keys on the main keyboard or the numeric 
keypad.

The input palette appears if the application you are using does not allow you to enter 
characters directly into a document. (See “Using the Input Palette and Inline Input” on 
page 44.)

If you type an incorrect number before you type the fourth number, you can press the Delete 
key to backspace over the character.

When you type the fourth digit in the code, the Big5 Code input mode converts the code to 
the Chinese character.
Note: If you type four digits that are not the code for a character, the system beeps.

English
word

Chinese
character Pinyin

Zhuyin 
keys

Zhuyin 
radicals

Apple ping qu/6

guo eji3

Computer dian 2uo4

nao sl3
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3 If you are using the input palette, press Return or Enter to enter the character.

For example, press the following keys to enter the characters for “Apple Computer”:

Entering Roman Characters

The Traditional Chinese Input Method provides several ways for you to enter Roman 
characters while you are entering Chinese characters. For example, you might need to 
include the name of a company or person in Roman characters in a business letter.

Entering Roman Characters While Using a Chinese Character Input Mode

While you are using a Chinese character input mode—Cangjie, Jianyi, Dayi, Pinyin, Zhuyin, or 
Big5 Code—you can do one of the following to enter Roman characters:
m To enter one-byte Roman characters, press the Caps Lock key and type the Roman 

characters. To type uppercase characters, press the Shift key while you type.
m To enter uppercase, two-byte Roman characters, hold down the Shift key while typing. 

Press the Space bar or Return to enter the characters. ( You cannot use this method with 
the Big5 Code input mode.)
Note: Be sure the Caps Lock key is not set.

m To enter a single two-byte Roman character, press the tilde (~) key, then press the letter 
you want to enter. This is useful, for example, if you want to enter a number. 

About One-Byte and Two-Byte Roman Characters

The Chinese input modes allow you to enter Roman characters as one-byte characters or 
two-byte characters. One-byte characters are the standard Roman characters. Two-byte 
Roman characters consist of two bytes each, like the Chinese characters, and have the same 
width as the Chinese characters. This form of the Roman characters is useful for producing 
simple layouts and forms because they align with the Chinese characters.

English
word

Chinese
character Pinyin Big5 Code

Apple ping c4ab

guo aa47

Computer dian b971

nao b8a3

Important  The Chinese fonts include only the basic Roman characters. You cannot enter 
Roman characters such as é or è unless you switch to a Roman keyboard layout.
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Entering Roman Characters Using the Password Input Mode

The Password input mode is provided by the Traditional Chinese Input Method so that you 
can enter AppleShare passwords. For example, when you open the Chooser and select an 
AppleShare server or a workstation using Personal File Sharing, you may be required to enter 
a user name and password to gain access to the information on the remote computer. To 
have your password recognized by the AppleShare software, you may need to use the 
Password input mode.

To use the Password input mode, follow these steps:

1 Choose Password from the Pencil menu.

2 Choose the Chooser from the Apple menu.

3 In the Chooser, select the AppleShare icon, zone (if any), and the server or workstation to 
which you want to gain access, and click OK.

4 In the dialog box that appears, type your user name in the Name box and your password in 
the Password box.

5 Click OK.

6 In the dialog box that appears, select the volumes you want access to and click OK.

Entering Punctuation, Symbols, Numbers, and Special Characters

Some Chinese punctuation marks are similar to those used in Roman-based languages. They 
are two-byte punctuation marks so that they align with the text correctly. In addition, 
Chinese includes a number of unique punctuation marks and symbols.

You can enter some Chinese punctuation marks by pressing the corresponding keys on the 
keyboard. However, if you are not sure which key to press or you want to use a special 
Chinese character, there are several ways you can do it:
m Choose Show Character Table from the Pencil menu. Choose “Punctuation and Symbols”

from the top pop-up menu in the palette. Double-click the character you want to enter.
m Choose Show Punctuation from the Pencil menu. Locate the punctuation mark or symbol 

in the palette and click it.

Important  If you try to gain access to an AppleShare server or workstation and your 
password is not accepted—and you are sure you entered it correctly—choose the Password 
input mode and try again.

Important  Be sure to type your user name and password correctly.
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Selecting and Editing Characters in a Document

After you have entered characters, you may need to change them. In general, you use the 
standard methods for selecting and editing text on your Mac OS computer.

Here are some points to keep in mind:
m If you have not completed entering the character, you can press the Delete key to delete 

the previous key you pressed.
m If you enter a character and want to enter the same character again, choose Enter 

Character Again from the Pencil menu.
m If you double-click a Chinese character that is part of a phrase or a two-byte Roman 

character that is part of a word, only that character is selected, not the entire phrase or 
word.

m If you are using a Chinese input mode and you click in an area with Roman text, the input 
method selects a Roman keyboard.

m If you are using a Roman keyboard and you click in an area with Chinese text, the Chinese 
input method is selected.

Entering Your Own Chinese Characters

You can use the TrueType Font Editor to create your own special Chinese characters and save 
them in font files (suitcases). You can then enter these characters in your documents. You 
might want to create a special Chinese character for the name of a company or person. To 
learn how to use the TrueType Font Editor, see the “About TrueType Font Editor” file in the 
Chinese Utilities folder in the Apple Extras folder.

After creating the character and saving it in a font suitcase, you must place the suitcase in the 
Fonts folder in the System Folder on your computer and restart your computer.

To enter the character you have created in a document, follow these steps:

1 Choose the font you created to use in your document.

How you do this depends on the application you are using. In SimpleText, you choose the 
font from the Font menu.

2 Choose Show User Defined Characters from the Pencil menu.
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The Show User Defined Characters palette appears.

3 Double-click the character to enter it in your document.
Note: If the character doesn’t appear in the document, be sure you have selected the 
correct font.

When you create a character in the TrueType Font Editor, a hexadecimal code is assigned to 
it. You can use the code to enter the character when you are using the Big5 Code input 
mode. You can also define a code for a character you have created so that you can enter the 
character by pressing keys when you are using the Cangjie, Jianyi, Dayi, Pinyin, or Zhuyin 
input mode.

To define a code for a character you have created, follow these steps:

1 Choose Show User Defined Characters from the Pencil menu.

2 Select the character in the palette.

3 Choose the input mode from the pop-up menu on the left.

4 Click the button on the right.

5 In the dialog box that appears, type the code in the text box and click OK.

Input codes and keys 
appear here.

Choose the input
mode here.

Choose the font you
created in the TrueType

Font Editor here.

Click here to enter a 
code for the character.
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Using Palettes

The Traditional Chinese Input Method provides a number of palettes that help you locate, 
select, and enter the characters, punctuation marks, numbers, and symbols that you want to 
use in your documents.

Using the Input Palette and Inline Input

Many applications let you enter characters using inline input. With inline input, you type the 
characters directly into the document. As you type, a line appears under the characters to 
indicate that they have not been entered into the document.

Some applications do not allow you to use inline input, so you must use the input palette. 
You may also see the input palette when you enter characters in a text box in a dialog box.

The input palette appears automatically when you start typing the keys to enter a Chinese 
character. If it appears, you can continue typing as though you were typing in the document 
window. When you are ready to enter a character into the document or dialog box, press the 
Space bar, Return, or Enter.
Note: The selection palette appears if more than one character matches the keys you 
entered.

Here are a few points to remember:
m Press the pop-up menu at the right of the input palette to choose a font for the palette.
m The input palette closes each time you enter a character. If you want to keep it open all 

the time, select the Keep Input Palette Open option in the Preferences dialog box. (See 
“Selecting General Preferences” on page 48.)

m The input palette lets you specify a single character, then enter it. If you want to keep 
characters in the input palette until you have completed a word or phrase consisting of 
two or more characters, choose Store Characters from the Pencil menu or select the 
option in the Preferences dialog box. (See “Selecting General Preferences” on page 48.)
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Using the Selection Palette

You see the selection palette when the input mode you are using identifies several characters 
that match the keys you pressed to specify a character. The selection palette displays the 
characters that match the keys you press so that you can enter them in your document. 
There are several ways you can select characters in the palette and enter them.
m Click to select and enter the character.
m Press the Up or Down Arrow keys to select a different row in the palette.
m Press the Left or Right Arrow keys to select adjacent characters in the palette.
m Press the Space bar to select the character to the right. Press the Shift key and Space bar 

to select the character to the left.
m Type the number next to the character, which enters the character in your document and 

closes the selection palette. The character must be on the row with the currently selected 
character for a number to appear next to it.

m When the character you want is selected, press Return. 

When you enter a character, the selection palette closes. You can press the Esc key or click 
the close box to close the palette.

Using the Operation Palette

You can use the operation palette to perform several tasks rather than using the menu 
commands.

You can also show or hide the operation palette with the Show Operation Palette or Hide 
Operation Palette command in the Pencil menu.

Important  If you are using the Jianyi input mode, pressing Return enters the first character 
that matches the keys you pressed even if there are other characters that match. If you want 
to select a different character, press the Space bar to open the selection palette.

Choose an input mode here.
Click here to see the Preferences dialog box.
Click here to open the Traditional Chinese Dictionary Tool application.
Click here to see the Character table.
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Using the Character Table

You can use the Character table to see the codes and key sequences used to enter characters, 
punctuation marks, and symbols. To see the table, choose Show Character Table from the 
Pencil menu or click the appropriate button in the operation palette.

The lower part of the table shows the characters of Traditional Chinese, or the Chinese 
punctuation marks and symbols. When you select a character in the table, the input codes 
and keys for entering the character appear at the top-right of the table.

Here’s how to use the table:

1 Choose from the Category (top) pop-up menu whether you want to see characters or 
punctuation marks and symbols in the table.

2 Choose the font you want to use from the Font (bottom) pop-up menu.

3 In the lower part of the palette, click to select the character, punctuation mark, or symbol 
you want to see information about.

The characters are in the order of their Big5 Code hexadecimal code.

When you select a character, you see this information about it in the top-right of the table:
m the Big5 Code code
m the Cangjie input keys
m the Dayi input keys
m the Pinyin spelling for the character
m the Zhuyin symbols to enter the character

4 To enter a character in your document, double-click it in the table.

Codes for characters 
appear here.

Choose characters or
punctuation here.

Choose a font here.
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Finding the Input Code for a Character

You can use the Find Input Code dialog box to look up the code for a character. You might 
use this dialog box to look up the keys to enter a character using the Cangjie or Dayi input 
mode when you already know the Pinyin spelling.

To look up the input keys for a character, follow these steps:

1 Choose the input mode for the keys to enter the character that you already know.

For example, choose Pinyin from the Pencil menu.

2 Choose Find Input Code from the Pencil menu.

The Find Input Code dialog box appears.

3 Press the keys for the character you want to look up.

For example, type ping2 if you are using the Pinyin input mode.

The input palette appears as you type.

4 Press Return.

5 If the selection palette appears, select the character and press Return.

The Chinese character appears in the text box in the dialog box.

6 Click the Find button.

The codes and input keys for the Cangjie, Dayi, Pinyin, Zhuyin, and Big5 Code input modes 
appear below the text box.

If you want to find the code for another character, enter it and click the Find button. The new 
code appears in the dialog box next to the first code separated by a comma.

7 When you are finished, click the Cancel button to close the dialog box.

Find buttonCancel button
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Selecting Preferences

You use the Preferences dialog box to select preferences for the way the input modes work. 
Some of the options and preferences you can select affect all the input modes, while others 
affect only certain input modes. To select preferences, follow these steps:

1 Choose Preferences from the Pencil menu.

The Preferences dialog box appears.

2 Select the preferences you want to use.

3 Click the OK button when you are finished.

Selecting General Preferences

Using the general preferences, you select options for the input modes.

Click the OK button here.

General preferences

Dictionary preferences

Input mode preferences

Zhuyin Frequency
Options

Show Input Keys

Show Associated Words
Store Characters

Use Simplified Pinyin
Keep Input Palette Open

Use Dynamic Search
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Here is a description of the options.

Option Description

Show Input Keys Click to select the checkbox to see the key sequences in the 
selection palette. This option is the same as choosing Show 
Input Keys from the Pencil menu.

Store Characters Click to select the checkbox to keep characters in the input 
palette until you are ready to enter the entire word or phrase. 
This option is the same as choosing Store Characters from the 
Pencil menu.

Show Associated Words Click to select the checkbox to see in the selection palette 
suggestions for subsequent characters to enter after you enter a 
character. This option is the same as choosing Show Associated 
Words from the Pencil menu.

Use Simplified Pinyin Click to select the checkbox to use a version of the Pinyin input 
mode that uses a simplified version of the Pinyin phonetic 
transcription system.

Keep Input Palette Open Click to select the checkbox to keep the input palette open 
after you enter a character. If this option is not selected, the 
input palette closes when you enter a character.

Use Dynamic Search Click to select the checkbox to have the input modes show the 
selection palette with the characters you can select as you type. 
For example, when you press “p,” the selection palette shows 
all the characters that start with that sound; when you press “i,”
the palette changes to show all the characters that start with 
“pi.” Dynamic search is useful if you are not familiar with Pinyin.

Zhuyin Frequency Options Click to select the checkbox to specify the method the Zhuyin 
input mode uses to select a character when the selection 
palette appears. The character selected is determined by the 
frequency of its use. You can select one of these options:
m Static—Selects a character based on the order defined by 

the input mode.
m Dynamic—Selects the character you have selected most 

often. The input mode saves the frequency with which you 
use characters.

m Most Recent—Selects the character you selected most 
recently.
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Selecting Dictionary Preferences

The input modes of the Traditional Chinese Input Method can search up to four dictionary 
files created using the Traditional Chinese Dictionary Tool, in addition to the built-in 
dictionary characters.

Using the Traditional Chinese Dictionary Tool application, you can create your own 
dictionary files. To do so, you specify phrases and the input codes to enter them. In addition, 
dictionary files are available that contain specialized vocabularies, such as those used in 
medicine and law.

Searching the dictionary files can slow down entering characters. While you can use as many 
as four dictionary files, you may not want to do so all the time. You can open and close 
dictionary files using the Preferences dialog box.

To use a dictionary file, follow these steps:

1 Copy the dictionary you want to use to the Extensions folder (in the System Folder) and 
restart your computer.

2 Choose Preferences from the Pencil menu.

The Preferences dialog box shows the dictionary in the Dictionary area. It also shows the 
Main Dictionary.

3 Select the dictionary you want to open and click the Open button.

4 Click OK to close the Preferences dialog box.

To close a dictionary file, open the Preferences dialog box, select the dictionary, and click the 
Close button. Then click the OK button to close the dialog box.

Entering a Phrase From a Dictionary File

To enter a phrase in a dictionary file, choose the Dayi input mode and enter the radicals you 
specified for the phrase.

You can also enter a phrase from a dictionary file using the Cangjie, Jianyi, Pinyin, or Zhuyin 
input mode. To do so, follow these steps:

Dictionaries in the Extensions 
folder appear here.

Click here to close the 
selected dictionary.

Click here to open the selected dictionary.
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1 Be sure the dictionary file is open in the Preferences dialog box.

2 Choose Show Associated Words from the Pencil menu.

3 Press the keys specified by the input mode you are using to enter the first character of the 
phrase.

4 Press the Space bar.

5 In the selection palette, locate and enter the phrase from the dictionary that you want to 
enter in your document.

Editing a Dictionary File

You use the Traditional Chinese Dictionary Tool application to create your own dictionaries 
or edit existing dictionaries.
Note: The Traditional Chinese Dictionary Tool application is in the Extensions folder (in the 
System Folder).

To use the Traditional Chinese Dictionary Tool, follow these steps:

1 Choose Edit User Dictionary from the Pencil menu.

The Traditional Chinese Dictionary Tool application opens and its menu bar appears.

In addition, a new, Untitled TC Dictionary window appears.

Note: The information below the text box shows the number of phrases defined in the 
dictionary, and the amount of free space available in the dictionary.

File menu

Edit menu

Dictionary menu

Free space in the 
dictionary shown here.

Number of phrases
in the dictionary

shown here.
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2 To create a new dictionary, go to step 3. If you want to open an existing dictionary to add 
phrases to it, choose Open from the File menu. In the dialog box that appears, locate the 
dictionary file and open it.

3 Choose the input mode you want to use to enter characters.

4 Choose New Phrase from the Dictionary menu.

The Edit Phrase dialog box appears.

5 Enter at least two Chinese characters for the phrase you want to add to the dictionary in the 
top text box.

The text area below the text box shows the suggested Dayi input keys for the phrase.

6 Enter the suggested Dayi input code or specify your own Dayi code for the phrase in the 
bottom text box. 

To enter the code, press the Caps Lock key and type the Roman characters for the code.

For more information about the Dayi input mode, see “Entering Chinese Characters Using 
the Dayi Input Mode” on page 31.

7 Click OK.

The new word or phrase appears in the window.

8 If you are creating a new dictionary, choose Save or Save As from the File menu. In the dialog 
box that appears, select where you want to save the dictionary file, type a name for it, and 
click OK.

To use a dictionary file it must be in the Extensions folder (in the System Folder). So you may 
want to save the dictionary in the Extensions folder. You must restart your computer to use 
the dictionary.

If you are adding a phrase to an existing dictionary file, choose Save.

Choose the New Phrase 
command here.

Enter the new 
phrase here.

Enter the code 
for the phrase here.

Click OK here.
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To change the code for a phrase or delete a phrase from the dictionary, follow these steps:

1 Choose Open from the File menu. In the dialog box that appears, locate the dictionary file
and open it.

2 If the dictionary contains a large number of phrases, type the code or enter the Chinese 
characters for the phrase in the text box near the top of the dictionary window.

3 Click the Search button.

The line containing the phrase is selected.

4 Double-click the line containing the phrase to open the Edit Phrase dialog box.

To delete the selected phrase, press Delete or choose Cut or Clear from the Edit menu.

In addition to allowing you to create dictionaries, add new phrases and edit them, the 
Traditional Chinese Dictionary Tool also lets you do the following:
m If you make changes to an existing dictionary and you want to revert to the previous 

version, choose “Revert to Saved” from the File menu.

Click Search here.Enter the phrase here.

Choose “Revert to Saved” here.
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m To save the phrases and their codes from a dictionary file to a text file, choose “Save as 
Text File” from the File menu.

In the dialog box that appears, select where you want to save the text file, type a name for 
the file, and click Save.

m To add phrases to the open dictionary file from another dictionary file, choose “Add
Phrases From a Dictionary File” from the Dictionary menu.

In the dialog box that appears, locate and select the dictionary file and click Open.
m To add phrases to the open dictionary file from a text file, choose “Add Phrases From a 

Text File” from the Dictionary menu.

In the dialog box that appears, locate and select the text file and click Open.

Choose “Save as Text File” here.

Choose “Add Phrases From a Dictionary File” here.

Choose “Add Phrases From a Text File” here.
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Selecting Input Mode Preferences

The input mode preferences let you select which input modes appear in the Pencil menu. 
Each input mode that appears in the Pencil menu uses some of your computer’s memory.

To prevent an input mode from appearing in the Pencil menu and using memory, follow 
these steps:

1 Choose Preferences from the Pencil menu.

2 Click to remove the checkmark from the checkbox of the input modes you want to turn off.

3 Click OK.

4 Restart your computer.

Resetting Default Preferences

You can reset the options and the positions of palettes to their factory settings. To do so, 
choose Reset Default Preferences from the Pencil menu.

Cangjie and Jianyi
input modes

Pinyin input mode
Dayi input mode

Zhuyin input mode
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C H A P T E R

4
4 Using the Simplified Chinese 

Input Method
What Is the Simplified Chinese Input Method?

The Simplified Chinese Input Method allows you to enter the simplified-style Chinese 
characters, sometimes called “GB Chinese.” This writing system is the standard writing 
system in China. It has more than 6,700 characters—significantly fewer characters than 
Traditional Chinese.

The Simplified Chinese Input Method provides four input modes for entering Chinese 
characters, one input mode for entering Roman characters, and the Password input mode for 
entering AppleShare passwords. In addition, the input method allows you to
m open palettes for looking up and entering characters, punctuation marks, and symbols
m add your own phrases in Chinese and Roman characters to the dictionary
m use dictionaries created with the Simplified Chinese Dictionary Tool, create new 

dictionaries, and add your own phrases to a dictionary
m display the key combinations to enter characters in the character selection palette
m display characters frequently associated with a character you enter

This chapter describes how to use each input mode and the other features of the Simplified
Chinese Input Method.

Starting to Use the Simplified Chinese Input Method

To begin to use the Simplified Chinese Input Method, follow the steps in this section.
Before you start:  You may want to open an application, such as Simplified Chinese 
SimpleText, so that you can enter Chinese characters while learning to use the input method.
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Step 1: Choose the Simplified Chinese Input Method

All input methods installed on your computer, including those of the Chinese Language Kit, 
appear in the Keyboard menu at the right side of the menu bar.

If the primary script on your computer is the Roman script, the Keyboard menu shows 
keyboard layouts at the top. The Chinese Language Kit input methods are near the bottom. If 
the primary script of your system software is the Chinese script, then the input methods 
appear at the top of the menu.

To use the Simplified Chinese Input Method, perform this step:
m Choose the Simplified Chinese Input Method from the Keyboard menu.

The Pencil menu appears in the menu bar.

Simplified Chinese
Input Method

Keyboard menu

Keyboard layouts
(Layouts available on your 
computer may be different.)

Input modes Input modes

Pencil menuPencil menu

Choose here to view 
the menu in Chinese.

Choose here to view
the menu in English.
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You use the Pencil menu to choose the input mode and other options you want to use for 
the Simplified Chinese Input Method. Some commands are available only in certain input 
modes.

When the Pencil menu appears, the operation palette also appears. The operation palette lets 
you perform some of the same tasks that you perform by choosing commands from the 
Pencil menu. 

Step 2: Choose an Input Mode

To choose the input mode you want to use, you can choose it from the Pencil menu, press 
the keys shown next to the input mode in the Pencil menu, or choose it from the pop-up 
menu in the operation palette.

Step 3: Choose Other Options and Preferences

After you choose an input mode, you may want to select other options or select preferences 
using the Preferences dialog box. Some options affect the behavior of all the input modes, 
while others are only available for certain input modes. See the next section, “Entering and 
Editing Characters,” to learn about the options you can select for each input mode.

Step 4: Enter the Character

How you enter characters depends on the input mode you are using. See the next section, 
“Entering and Editing Characters,” to learn how to enter characters using each of the input 
modes.

As you enter characters you may see one or more palettes:
m The input palette appears if the application or dialog box where you are entering 

characters does not allow you to enter characters directly into a document or text box. 
(See “Using the Input Palette and Inline Input” on page 82.)

m The selection palette appears if the input mode matches more than one Chinese 
character with the keys you press. You can select and enter a character from the palette. 
(See “Using the Selection Palette” on page 83.)
If you choose Show Input Keys from the Pencil menu, you will see the keys for entering 
characters in the selection palette.

Important  When the Pencil menu appears, it is in Chinese. If you want to see the menu 
items in English, choose Show English Menu from the menu.

Choose an input mode here.
Click here to see the Preferences dialog box.
Click here to see the User Dictionary dialog box.
Click here to see the Character table.



60 Chapter  4

Entering and Editing Characters

The Simplified Chinese Input Method provides the following input modes.

The following sections describe how to use each of the input modes provided with the 
Simplified Chinese Input Method.

Entering Chinese Characters Using the Wubi Xing Input Mode

The Wubi Xing input mode defines 25 radicals, which are assigned to the keys on the main 
keyboard. The following illustration shows the location of the radicals on the keyboard.

Note: The Wubi Xing radicals are based on the Wubi Hua strokes.

To enter characters using the Wubi Xing input mode, you press the keys of the radicals in the 
order of the strokes that make up the character. Therefore, you need to know how to write 
the Simplified Chinese characters.

To enter a character using the Wubi Xing input mode, follow these steps:

Input mode Method for entering characters

Wubi Xing Press keys for the radicals you use to write the character.

Wubi Hua Press numeric keypad keys 0–6 for the strokes you use to write 
the character.1

ABC Press Roman keys to spell the character phonetically using the 
Pinyin transcription system.

Quwei Press a numeric GB code for the character.

Roman Press keys to enter one-byte Roman characters.

Password Press keys to enter an AppleShare password.2

1 If your keyboard does not have a numeric keypad, you can use alphabetic keys to represent the strokes. (See “Selecting Wubi 
Hua Preferences” on page 89.)

2 If your AppleShare password is not accepted and you are sure you have typed the password correctly, choose this input mode 
before you enter the password again.

Z , . /

W E R T YQ U I O P

;A S D F G H J K L

X C V B N M
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1 Choose Wubi Xing from the Pencil menu.

2 Select the options you want to use:

3 Press the keys for the radicals to enter the character.

The input palette appears if the application you are using does not allow you to enter 
characters directly into a document. (See “Using the Input Palette and Inline Input” on 
page 82.)

If you aren’t sure which key to use for a radical, press z.
Note: If you don’t know the key sequence for a character, you can use the Find Input Code 
dialog box. See “Finding the Input Code for a Character” on page 85 later in this chapter.

4 Press the Space bar, Return, or Enter.

The Wubi Xing input mode searches for a character that matches the one you have entered. 
If more than one character matches, the selection palette appears. (See “Using the Selection 
Palette” on page 83.)

5 If the selection palette appears, find the character you want to enter and click it to enter it in 
the document or input palette. (See “Using the Selection Palette” on page 83.)

6 If you are using the input palette, press the Space bar, Return, or Enter to enter the character.

If you want to Do this:

See the keys to enter characters 
in the selection palette

Choose Show Input Keys from the Pencil menu.

Keep the input palette open 
while entering characters

Choose Preferences from the Pencil menu and select the Keep 
Input Palette Open option. (See “Selecting General 
Preferences” on page 87.)

Use Simplified Chinese 
Dictionary Tool dictionary files

Choose Preferences from the Pencil menu and select the 
dictionary files to use. (See “Selecting Dictionary Preferences”
on page 90.)
You can also search all dictionary files. (See “Selecting General 
Preferences” on page 87.)
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For example, press the following keys to enter the characters for “Apple Computer”:

Entering Characters Quickly

The Wubi Xing input mode provides several ways for you to enter characters quickly. 

The input mode specifies a Chinese character for each of the keys. You can use these single 
keys to enter these frequently used characters:

English
word

Chinese 
character Pinyin

Wubi Xing 
keys

Apple ping AGUh

guo JSi

Computer dian JNv

nao EYBh

Key Character Key Character Key Character

a j s

b k t

c l u

d m v

e n w

f o x

g p y

h q z wild card

i r
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Some characters can be entered with two or three keys rather than the complete sequence to 
specify the character. Following are several examples.

There are several other ways in which the input mode makes it faster to enter characters.

To enter this character: Press these keys:

sb

wx

wy

xt

bai

shn

tjg

wxf

Description Keys Character

Alternative input keys

The input mode enters the same character for 
similar sequences.

x

xc

xca

xcag

Automatic correction

The input mode recognizes common errors and 
selects the correct character automatically.

tay

tgny

gnty

Quick phrase entry

By typing quickly, you can enter sequences for 
Chinese phrases consisting of more than one 
character.

buje



64 Chapter  4

Entering Chinese Characters Using the Wubi Hua Input Mode

The Wubi Hua input mode defines five strokes that you use to write Chinese characters. 
These strokes are assigned to the numeric keypad keys 1–5. In addition, two other keys—0
and 6—are used for special purposes.

To enter characters using the Wubi Hua input mode, follow these steps:

1 Choose Wubi Hua from the Pencil menu.

2 Select the options you want to use:

3 Press the keys for the strokes in the same order you use to write the character.

1 2 3

0

4 5 6

7 8 9

Press this key if you are not sure which stroke 
to use when entering a character.

Press this key to indicate that there are no more strokes 
if a character requires fewer than five strokes to write.

If you want to Do this:

Use alphabetic keys Select the option to use alphabetic keys in the Preferences 
dialog box. (See “Selecting Preferences” on page 86.) You might 
need to do this if your keyboard does not have a numeric 
keypad.

Keep the input palette open 
while entering characters

Choose Preferences from the Pencil menu and select the Keep 
Input Palette Open option. (See “Selecting General 
Preferences” on page 87.)

Automatically select characters 
you use frequently 

Select the Wubi Hua Frequency Order option in the Preferences 
dialog box. (See “Selecting Wubi Hua Preferences” on page 89.)

See the keys to enter characters 
in the selection palette

Choose Show Input Keys from the Pencil menu.

See suggestions for subsequent 
characters to enter

Choose Show Associated Words from the Pencil menu.
The selection palette appears after you enter a character 
showing characters that commonly follow the one you entered.
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You can press up to five keys using the following rules:

The sequence must follow the order for writing the strokes for the character:  left to right, 
top to bottom, outside to inside.

The input palette appears if the application you are using does not allow you to enter 
characters directly into a document. (See “Using the Input Palette and Inline Input” on 
page 82.)

As you press the keys, the Wubi Hua input mode searches for characters that match the 
strokes you are entering. The selection palette appears for you to select a character.

4 Use the selection palette to select and enter the character you want. (See “Using the 
Selection Palette” on page 83.)

For example, press the following keys to enter the characters for “Apple Computer”:

If writing the 
character requires Do this:

Fewer than five strokes Press the keys for the strokes, then press the 0 key to indicate 
when you are finished.

Exactly five strokes Press the keys for the strokes.

More than five strokes Press the keys for the first four strokes, then the key for the 
final stroke used to write the character.

English
word

Chinese 
character Pinyin

Wubi Hua 
keys

Apple ping 12212

guo 25114

Computer dian 25115

nao 35112
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Entering Chinese Characters Using the ABC Input Mode

Using the ABC input mode, you enter Chinese characters by typing Roman characters to spell 
the character phonetically. The phonetic spelling is based on the Pinyin phonetic 
transcription of the Chinese character. (See the Appendix, “Phonetic Transcription Systems 
for Chinese,” on page 97 for a table of the phonetic transcription systems.)

The ABC input mode has two variations:
m ABC Standard lets you enter Chinese characters using the standard Pinyin spelling.
m ABC Double Type lets you enter Chinese characters by typing two keys for the Pinyin 

spelling. (See “Using the ABC Double Type Input Mode” on page 68.)

You can also enter characters by pressing keys for strokes when using either the ABC 
Standard or ABC Double Type input mode. (See “Using Stroke Input With the ABC Input 
Mode” on page 71.)

Using the ABC Standard Input Mode

ABC Standard input mode lets you enter Chinese characters using standard Pinyin or 
Simplified Pinyin. (See “Using Simplified Pinyin” on page 70.)

The ABC Standard input mode also lets you enter characters by pressing keys for strokes, 
either by themselves or combined with Pinyin input keys. (See “Using Stroke Input With the 
ABC Input Mode” on page 71.)

To enter a Chinese character using the ABC Standard input mode, follow these steps:

1 Choose ABC Standard from the Pencil menu.
Note: If the menu shows ABC Double Type, choose Preferences from the Pencil menu and 
select the ABC Standard option. (See “Selecting ABC Preferences” on page 88.)



 Using the Simplified Chinese Input Method 67

2 Select the options you want to use:

3 Press the keys for the Roman characters that phonetically spell the Chinese character you 
want to enter using Pinyin.

The ABC Standard input mode provides a number of ways to abbreviate entering characters. 
If you want to use abbreviated input, see “Using Abbreviated Input” on page 73.

If you want to use Simplified Pinyin to enter characters, see “Using Simplified Pinyin” on 
page 70.

If you want to enter the character using strokes, see “Using Stroke Input With the ABC Input 
Mode” on page 71.

The input palette appears if the application you are using does not allow you to enter 
characters directly into a document. (See “Using the Input Palette and Inline Input” on 
page 82.)

4 If you want to enter a phrase consisting of two or more characters, you can continue pressing 
keys for the other characters.

If you want to Do this:

Automatically select characters 
you use frequently 

Choose Preferences from the Pencil menu and select the ABC 
Frequency option. (See “Selecting ABC Preferences” on 
page 88.)

Enter characters only by 
pressing keys for strokes

Choose Preferences from the Pencil menu and select the Pure 
Xing option. (See “Using Stroke Input With the ABC Input 
Mode” on page 71 and “Selecting ABC Preferences” on 
page 88.)

Keep the input palette open 
while entering characters

Choose Preferences from the Pencil menu and select the Keep 
Input Palette Open option. (See “Selecting General 
Preferences” on page 87.)

See suggestions for subsequent 
characters to enter

Choose Show Associated Words from the Pencil menu.
The selection palette appears after you enter a character 
showing characters that commonly follow the one you entered.
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5 When you finish entering the keys, press the Space bar or Return.

The ABC input mode searches in the character table for a character that matches the one you 
entered. In most cases more than one character will match the sequence you have entered, 
so the selection palette appears.

If you have entered keys for a phrase, the selection palette shows the characters for the first
character you entered.

6 Use the selection palette to select and enter the character you want. (See “Using the 
Selection Palette” on page 83.)

If you have entered keys for a phrase, the selection palette shows the characters that match 
the next character. You can continue selecting characters until you have finished entering the 
phrase.

For example, press the following keys to enter the characters for “Apple Computer”:

Using the ABC Double Type Input Mode

The ABC Double Type input mode is used by professional typists to enter Chinese characters 
quickly. It uses a combination of Standard Pinyin, Simplified Pinyin, and other abbreviations 
for entering characters. (See “Using Simplified Pinyin” on page 70 and “Using Abbreviated 
Input” on page 73.)
Note: You must know how to use Double Type.

The ABC Double Type input mode also lets you enter characters by pressing keys for strokes, 
either by themselves or combined with Pinyin input keys. (See “Using Stroke Input With the 
ABC Input Mode” on page 71.)

To use ABC Double Type, you must select the Double Type option in the Preferences dialog 
box to enter characters. (See “Selecting ABC Preferences” on page 88.) When you select this 
option, the ABC Standard command changes to ABC Double Type.

English word Chinese character ABC keys (Pinyin)

Apple ping

guo

Computer dian

nao
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To enter a character using ABC Double Type, you press two keys to spell the character 
phonetically:
m If the sound of the character starts with a consonant, press the key for the consonant 

sound first, then press the key for the vowel.
m If the sound of the character starts with a vowel, press the o key, then the key for the 

vowel, followed by the key for the consonant.

As you type, the input mode converts the keys to the standard Pinyin spelling. In some cases, 
when you press a key several letters appear. (See “Using Simplified Pinyin” on page 70.)

Like the ABC Standard input mode, you can enter a single Chinese character or a phrase 
consisting of several Chinese characters before you select the characters you want.

When you finish entering the keys, press the Space bar or Return. The selection palette 
appears for you to select the character you want to enter. If you have entered keys for several 
characters, the selection palette remains open for you to select each character in the phrase.

For example, press the following keys to enter the characters for “Apple Computer”:

English
word

Chinese 
character Pinyin ABC Double Type keys

Apple ping py

guo go

Computer dian dw

nao nk
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Using Simplified Pinyin

The ABC input mode lets you use Simplified Pinyin to enter common sound combinations by 
typing a single character. The following table shows the keys you press for the sounds.

To enter this sound: Press this key:

ch i

sh u

zh a

ai l

an j

ang h

ao k

en f

eng g

ing y

ong s

ü v
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Using Stroke Input With the ABC Input Mode

The ABC input mode lets you press number keys to enter strokes that make up the character. 
You can use strokes with either the ABC Standard or ABC Double Type input mode.

You can use strokes in combination with the Pinyin spelling of the character. You can also use 
only strokes to enter characters. To use only strokes to enter a character, select the Stroke 
Only Input option in the Preferences dialog box. (See “Selecting ABC Preferences” on 
page 88.)
Note: If a character has more than one syllable, you must use Pinyin to enter it.

The ABC input mode defines eight strokes that you use to specify characters. Each stroke is 
assigned to a number key.

The first six strokes are individual strokes. The strokes for 7 and 8 are actually combinations 
of strokes. If a character contains the strokes for 7 or 8, use that key rather than the 
individual strokes.

You can enter up to six strokes for a character. How you enter the stroke depends on the 
complexity of the character:
m For simple characters, enter the strokes in the same order you would use to write the 

character.
m For complex characters, divide the character into two parts:  right and left, upper and 

lower, or inside and outside. You can enter three strokes for each part.

To enter this stroke: Press this number key:

1

2

3

4

5

6

7

8
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For example, press the following keys to enter the characters for “Apple Computer” using 
both Pinyin and strokes:

Press the following keys to enter the characters for “Apple Computer” using only strokes:

English
word

Chinese 
character Pinyin

ABC Stroke 
Input keys

Apple ping p72

guo g87

Computer dian d81

nao n35

English
word

Chinese 
character Pinyin

ABC Stroke 
Input keys

Apple ping 721437

guo 87134

Computer dian 816

nao 35141
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Using Abbreviated Input

The ABC input mode provides two ways you can abbreviate entering characters.

Using Special Keys

The ABC input mode defines several keys that you can use to perform special operations.
m To enter the last character you entered again, press the Control and hyphen (-) keys.
m To enter the Chinese sound represented by ü, press the v key.
m To enter the Chinese numbers 1 through 9, press the i key and a number key.

ABC Special Character Palettes

The ABC input mode provides a number of palettes that let you select and enter special 
characters. The palettes contain punctuation, numbers, Roman characters, Greek characters, 
and other symbols that you may need to enter in your document.

Press these keys to see one of the ABC special character palettes:  v1, v2, v3, v4, v5, v6, v7,
v8, v9.

Description
Press these 
keys

For these 
characters

Shift key

Press the Shift key while pressing the keys for the first
sound of each character in a common phrase. The 
selection palette appears showing phrases that match 
the keys you have pressed.

ZG

Apostrophe key

Press the key for the first sound of a character, then 
press the apostrophe key (’). The selection palette 
appears showing characters that match the key.
Because ABC lets you press keys for several characters 
before converting them, you can enter a phrase.

zh’g
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Using the User Dictionary

The ABC input mode lets you define your own input sequences for Chinese and English 
words and phrases that you can then enter in your document.

The ABC input mode also lets you use dictionary files created with the Simplified Chinese 
Dictionary Tool. (See “Selecting Dictionary Preferences” on page 90.) 

To define an input sequence for a word or phrase, follow these steps:

1  Choose Edit User Dictionary from the Pencil menu.

The User Dictionary dialog box appears.

2 In the first text box, type the characters for the word or phrase you want to enter:
m You can enter up to 15 Chinese characters. Enter Chinese characters as you normally do 

using the ABC input mode.
m You can enter up to 30 one-byte Roman characters. To enter one-byte Roman characters, 

press the Caps Lock key and type.
Note: You can also use the Roman input mode.

m You can enter up to 15 two-byte Roman characters. To enter two-byte Roman characters, 
choose Use Two Byte Roman Characters from the Pencil menu before you open the dialog 
box.

Type the word or phrase
you want to enter here.

Type the Roman
characters to enter the

word or phrase here.

Words and phrases
you have defined

appear here.
Click here to close 
the dialog box.

To delete an item, 
select it and click 
the Delete button.

Click Add to save 
the phrase.
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3 In the second text box, type the one-byte Roman characters you want to use to enter the 
word or phrase.

To do so, press the Caps Lock key, if it isn’t set already, or choose the Roman input mode and 
type.

You can type up to nine Roman characters.

4 Click the Add button.

You can now enter other words and phrases in the dialog box.

5 Click the Close button to close the dialog box.

To enter a word or phrase you have defined in the User Dictionary, follow these steps:

1 While using the ABC input mode to enter characters in a document, type u.

2 Type the Roman character code you assigned to the word or phrase.

3 Press the Space bar, Return, or Enter.

The word or phrase appears in your document.

To delete a phrase you have defined from the dictionary, open the User Dictionary, select the 
item, and click the Delete (middle) button.
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Entering Chinese Characters Using the Quwei Input Mode

The Quwei input mode allows you to enter Chinese characters by typing a 4-digit decimal 
code for each character. To use this input mode you must know the “GB Chinese” code for 
the characters. You can use the Character table to look for characters and see their codes. 
(See “Using the Character Table” on page 84 later in this chapter.)

To use the Quwei input mode, follow these steps:

1 Choose Quwei from the Pencil menu.

2 Using the number keys on the main keyboard or the numeric keypad, type the 4-digit “GB
Chinese” code for the character you want to enter.

If you type an incorrect number before you type the fourth number, you can use the Delete 
key to backspace over the character.

When you type the fourth digit in the code, the Quwei input mode converts the code to the 
Chinese character and inserts it in your document. A line will remain under the character 
until you type the next key.
Note: If you type four digits that are not the code for a character, the system beeps and the 
numbers you typed are deleted.

3 Type the “GB Chinese” code for the next character, or press the Space bar, Return, or Enter 
key to enter the character in your document.

For example, press the following keys to enter the characters for “Apple Computer”:

English
word

Chinese 
character Pinyin Quwei code

Apple ping 3827

guo 2591

Computer dian 2171

nao 3652
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Entering Roman Characters

The Simplified Chinese Input Method provides several ways for you to enter Roman 
characters while you are entering Chinese characters. For example, you might need to 
include the name of a company or person in Roman characters in a business letter. 

Entering Roman Characters While Using a Chinese Character Input Mode

While you are using the Chinese character input modes—Wubi Xing, Wubi Hua, ABC, or 
Quwei—you have several ways to enter Roman characters in your document. You can choose 
a Roman keyboard or the Roman input mode to enter the Roman characters, but entering 
Roman characters while using the Chinese input mode is faster.

To enter Roman characters, you can do one of the following:
m To enter one-byte Roman characters, press the Caps Lock key and type the Roman 

characters you want to enter. To type uppercase characters, hold down the Shift key while 
you type.

m To enter two-byte Roman characters for any of the Chinese input modes, choose Use Two 
Byte Roman Characters from the Pencil menu.

m To enter uppercase, two-byte Roman characters while using the Wubi Xing or Wubi Hua 
input modes, hold down the Shift key while typing.
Note: Be sure the Caps Lock key is not set.

m To enter Roman characters while using the ABC input mode, you can use the special 
character palettes provided by the input mode. See “ABC Special Character Palettes” on 
page 73.

About One-Byte and Two-Byte Roman Characters

The Chinese input modes allow you to enter Roman characters as one-byte characters or 
two-byte characters. One-byte characters are the standard Roman characters. Two-byte 
Roman characters consist of two bytes, like the Chinese characters, and have the same width. 
This form of the Roman characters is useful for producing simple layouts and forms because 
they align with the Chinese characters.

Important  The Chinese fonts include only the basic Roman characters. You cannot 
enter Roman characters such as é or è unless you switch to a Roman keyboard.
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Entering Roman Characters Using the Roman Input Mode

The Roman input mode allows you to enter one-byte Roman characters in your Chinese 
documents. To use the Roman input mode, follow these steps:

1 Choose Roman from the Pencil menu.

2 Type the characters you want to enter.

3 When you are finished, choose another input mode.

Note: When you choose the Roman input mode, you are still using the Chinese character 
fonts, which include only the basic Roman characters. Therefore, you cannot enter some 
Roman characters. For example, you cannot enter characters such as å, é, è, î, ø, ü, and ñ. To 
enter these characters, choose a Roman keyboard layout installed on your system and a 
Roman font.

Entering Roman Characters Using the Password Input Mode

The Password input mode is provided by the Simplified Chinese Input Method so that you 
can enter AppleShare passwords. For example, when you open the Chooser and select an 
AppleShare server or a workstation using Personal File Sharing, you may be required to enter 
a user name and password to gain access to the information on the remote computer. To 
have your password recognized by the AppleShare software, you may need to use the 
Password input mode.

To use the Password input mode, follow these steps:

1 Choose Password from the Pencil menu.

2 Choose the Chooser from the Apple (K) menu.

3 In the Chooser, select the AppleShare icon, zone (if any), and the server or workstation to 
which you want to gain access, and click OK.

4 In the dialog box that appears, type your user name in the Name box and your password in 
the Password dialog box.

5 Click OK.

6 In the dialog box that appears, select the volumes you want access to and click OK.

Important  If you place the insertion mark within Roman characters, and the primary script 
of your system software is the Roman script, a Roman script keyboard layout will be selected.

Important  If you try to gain access to an AppleShare server or workstation and your 
password is not accepted—and you are sure you entered it correctly—choose the Password 
input mode and try again.

Important  Be sure to type your user name and password correctly.
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Entering Punctuation, Symbols, Numbers, and Special Characters

Some Chinese punctuation marks are similar to those used in Roman-based languages. They 
are two-byte punctuation marks so that they align with the text correctly. In addition, 
Chinese includes a number of unique punctuation marks and symbols.

You can enter some Chinese punctuation marks by pressing the corresponding key on the 
keyboard. However, if you are not sure which key to press or you want to use a special 
Chinese character, there are several ways you can do it:
m Choose Show Character Table from the Pencil menu. Choose “Punctuation and Symbols”

from the top pop-up menu in the palette. Double-click the character you want to enter.
m If you are using the Wubi Xing, Wubi Hua, or Quwei input mode, choose Show 

Punctuation from the Pencil menu. Locate the punctuation mark or symbol in the palette 
and click it.

m If you are using the ABC input mode, press v and a number (1–9) to see the special 
character palettes of punctuation marks, numbers, Roman characters, Greek characters, 
and symbols.

Selecting and Editing Characters in a Document

After you have entered characters, you may need to change them. In general, you use the 
standard methods for selecting and editing text on your Mac OS computer.

Here are some points to keep in mind:
m If you have not completed entering the character, you can press the Delete key to delete 

the previous key you pressed. If the keys you pressed have been converted to a Chinese 
character but you have not pressed the Space bar, Return, or Enter to complete entering 
the key, the Chinese character will be replaced by the Roman keys.

m If you double-click a Chinese character that is part of a phrase or a two-byte Roman 
character that is part of a word, only that character is selected, not the entire phrase or 
word.

m If you are using a Chinese input mode and you click in an area with Roman text, the 
input method selects a Roman keyboard.

m If you are using a Roman keyboard and you click in an area with Chinese text, the 
Chinese input method is selected.
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Entering Your Own Chinese Characters

You can use the TrueType Font Editor to create your own special Chinese characters and save 
them in font files (suitcases). You can then enter these characters in your documents. You 
might want to create a special Chinese character for the name of a company or person. To 
learn how to use the TrueType Font Editor, see the “About TrueType Font Editor” file in the 
Chinese Utilities folder in the Apple Extras folder.

After creating the font and saving it in a suitcase, you must place the suitcase in the Fonts 
folder in the System Folder on your computer and restart your computer.

To enter the character you have created in a document, follow these steps:

1 Choose the font you created to use in your document.

How you do this depends on the application you are using. In SimpleText, you choose the 
font from the Font menu.

2 Choose Show User Defined Characters from the Pencil menu.

The character palette appears.

3 Double-click the character to enter it in your document.
Note: If the character doesn’t appear in the document, be sure you have selected the 
correct font.

Choose the input
mode here.

Choose the font you
created in the TrueType

Font Editor here.

Click here to enter a 
code for the character.

Input codes and keys 
appear here.
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You can also enter a character you have defined if you are using the Wubi Xing, Wubi Hua, 
ABC, or Quwei input mode. To do so, follow these steps:

1 Press the tilde (~) key.

A selection palette appears showing the characters you have defined.

2 Select the character in the palette and press Return to enter it.

When you create a character in the TrueType Font Editor, a decimal code is assigned to it. You 
can use the code to enter the character when you are using the Quwei input mode. You can 
also specify the keys to press to enter a character you have created when you are using the 
Wubi Xing, Wubi Hua, and ABC input modes.

To specify the keys to press to enter a character you have created, follow these steps:

1 Choose Show User Defined Characters from the Pencil menu.

2 Select the character in the palette.

3 Choose the input mode from the pop-up menu on the left.

4 Click the button on the right.

A dialog box appears for you to specify the input keys you want to use.

5 In the text box, press the keys you want to use to enter the character:
m For Wubi Hua, you can only use the alphabetic keys.
m For Wubi Xing, you can only use the numbers between 1 and 5.
m For ABC, you can only use the alphabetic keys.

6 Click OK.
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Using Palettes

The Simplified Chinese Input Method provides a number of palettes that help you locate, 
select, and enter the characters, punctuation marks, numbers, and symbols that you want to 
use in your documents.

Using the Input Palette and Inline Input

Many applications let you enter characters using inline input. With inline input, you type the 
characters directly into the document. As you type, a line appears under the characters to 
indicate that they have not been entered into the document.

Some applications do not allow you to use inline input, so you must use the input palette. 
You may also see the input palette when you enter characters in a text box in a dialog box.

The input palette appears automatically when you start typing the keys to enter a Chinese 
character. If it appears, you can continue typing as though you were typing in the document 
window. When you are ready to enter a character into the document or dialog box, press the 
Space bar, Return, or Enter.
Note: The selection palette appears if more than one character matches the keys you 
entered.

Here are a few points to remember:
m Press the pop-up menu at the right of the input palette to choose a font for the palette.
m The input palette closes each time you enter a character. If you want to keep it open all 

the time, select the Keep Input Palette Open option in the Preferences dialog box. (See 
“Selecting Preferences” on page 86.)
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Using the Selection Palette

The Simplified Chinese Input Method provides selection palettes for you to select characters, 
punctuation, symbols, and special characters in these cases:
m If you are using the Wubi Xing, Wubi Hua, or ABC input mode, and more than one 

Chinese character matches the keys you enter
m If you are using the Wubi Hua or ABC input mode, and you choose Show Associated 

Words from the Pencil menu
m If you are using the Wubi Xing, Wubi Hua, or Quwei input mode, and you choose Show 

Punctuation from the Pencil menu
m If you are using the ABC input mode, and press v followed by a number (1–9)

There are several ways you can select characters in the palettes and enter them into your 
document.
m Click the character.
m Press the Up or Down Arrow keys to select a different row in the palette.
m Press the Left or Right Arrow keys to select adjacent characters in the palette.

When the character you want is selected, press the Space bar, Return, or Enter to enter it 
into your document.

m Type the number adjacent to the character, which enters the character in your document 
and closes the selection palette. The character must be on the row with the currently 
selected character for a number to appear next to it.

Note: When you enter a character, the selection palette closes immediately. You can also 
press the Esc key or click the close box to close the palette.

Using the Operation Palette

You can use the operation palette to perform several tasks rather than using the menu 
commands.

You can also show or hide the operation palette with the Show Operation Palette or Hide 
Operation Palette command in the Pencil menu.

Choose an input mode here.
Click here to see the Preferences dialog box.
Click here to see the Dictionary dialog box.
Click here to see the Character table.
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Using the Character Table

You can use the Character table to see the codes and key sequences used to enter characters, 
punctuation marks, and symbols. To see the palette, choose Show Character Table from the 
Pencil menu or click the appropriate button in the operation palette.

The lower part of the table shows the characters of Simplified Chinese, or the Chinese 
punctuation marks and symbols. When you select a character in the table, the input codes 
and keys for entering the character defined by different input modes appear at the top-right 
of the table.

Here’s how to use the table:

1 Choose from the Category (top) pop-up menu whether you want to see characters or 
punctuation marks and symbols in the table.

2 Choose the font you want to use from the Font (bottom) pop-up menu.

3 Click to select the character, punctuation mark, or symbol you want to see information 
about.
Note: The characters are in the order of their Quwei input code.

When you select a character, you see this information about it in the top-right of the palette:
m the Quwei input code
m the Pinyin spelling for the character, which you can use with the ABC input mode
m the Wubi Xing keys to enter the radicals that make up the character

Note: Some of the keys are shown as uppercase, some as lowercase. Uppercase keys 
indicate the radicals that are required to enter the character; lowercase keys are optional.

m the Wubi Hua keys to enter the strokes that make up the character

4 To enter a character in your document, double-click it in the table.

Choose a font here.
Codes for characters appear here.

Choose to see characters
or punctuation here.
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Finding the Input Code for a Character

You can use the Find Input Code dialog box to look up the code for a character. You might 
use this dialog box to look up the Wubi Xing or Wubi Hua keys to enter a character when you 
already know the Pinyin spelling to use with the ABC input mode.

To look up the input keys for a character, follow these steps:

1 Choose the input mode for the keys to enter the character that you already know.

For example, choose ABC Standard from the Pencil menu.

2 Choose Find Input Code from the Pencil menu.

The Find Input Code dialog box appears.

3 Press the keys for the character you want to look up.

For example, type ren if you are using the ABC Standard input mode.

The input palette appears as you type.

4 Press the Space bar, Return, or Enter.

5 If the selection palette appears, select the character you want and press Return.

The Chinese character appears in the text box in the dialog box.

6 Click the Find button.

The codes and input keys for Wubi Xing, Wubi Hua, ABC Standard, and Quwei appear below 
the text box.

If you want to find the code for another character, enter it and click the Find button. The new 
code appears in the dialog box next to the first code, separated by a comma.

7 When you are finished, click the Cancel button to close the dialog box.

Find button

Cancel button
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Selecting Preferences

You use the Preferences dialog box to select preferences for the way the input modes work. 
Some of the options and preferences you can select affect all the input modes, while others 
affect only certain input modes.

To select preferences using the Preferences dialog box, follow these steps:

1 Choose Preferences from the Pencil menu.

The Preferences dialog box appears.

2 Select the preferences you want to use.

The Preferences dialog box lets you select
m general preferences
m preferences for the ABC input mode
m options for the Wubi Hua input mode
m dictionaries created with the Simplified Chinese Dictionary Tool 

3 Click the OK button when you are finished.

Click the OK button here.

Wubi Hua preferences Dictionary preferences

ABC preferencesGeneral preferences
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Selecting General Preferences

Using the general preferences, you select options that apply to several of the input modes or 
to all of the input modes.

Here is a description of the options.

Show Input Keys

Keep Input
Palette Open

Show Associated Words

Search All Dictionaries

Option Description

Show Input Keys Click to select the checkbox to see the key sequences in the 
selection palette when using the Wubi Xing or Wubi Hua input 
modes. This option is the same as selecting Show Input Keys 
from the Pencil menu.

Show Associated Words Click to select the checkbox to see in the selection palette 
suggestions for subsequent characters to enter after you enter a 
character when you are using the Wubi Hua or ABC Standard 
input mode. This option is the same as selecting Show 
Associated Words from the Pencil menu.

Keep Input Palette Open Click to select the checkbox to keep the input palette open 
after you enter a character. If this option is not selected, the 
input palette closes when you enter a character.

Search All Dictionaries Click to select the checkbox to use all the dictionaries listed in 
the Preferences dialog box, whether or not they are open. This 
option only applies to the Wubi Hua and ABC input modes. 
(See “Selecting Dictionary Preferences” on page 90.)
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Selecting ABC Preferences

The ABC preferences let you select alternative input methods for the ABC input mode and 
determine how characters are selected in the selection palette.

Here’s a description of the options.

Stroke Only Input
Double Type Input Mode

Use Frequency

ABC Standard
Input Mode

Option Description

ABC Standard Input Mode Select this option to use the ABC Standard input mode. (See 
“Using the ABC Standard Input Mode” on page 66.)

ABC Double Type Input Mode Select this option to use the ABC Double Type input mode. 
(See “Using the ABC Double Type Input Mode” on page 68.)

Stroke Only Input Click to select the checkbox to enter characters using only the 
stroke input keys. (See “Using Stroke Input With the ABC Input 
Mode” on page 71.)

Use Frequency Click to select the checkbox to have the input mode 
automatically select characters in the selection palette that you 
have selected previously, rather than selecting the first
character that matches the Pinyin you have entered.
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Selecting Wubi Hua Preferences

You can select two options for the Wubi Hua input mode.

Here’s a description of the options:
m If you do not have a numeric keypad, click to select the checkbox to use alphabetic keys 

to type the strokes. You can use the default keys shown in the dialog box, or enter other 
keys you want to use.

m Select an Order option to determine which character the input mode selects when the 
selection palette appears:
m Select Standard Order if you want the input mode to select the character that it 

defines as the most likely character you want to enter.
m Select Frequency Order if you want the input mode to select the character that you 

have selected the most often.

Frequency Order

Select this checkbox to
use alphabetic keys.

Standard Order

The numbers 0 through 6



90 Chapter  4

Selecting Dictionary Preferences

The Wubi Hua and ABC Standard input modes can search up to four dictionary files created 
using the Simplified Chinese Dictionary Tool, in addition to the built-in dictionary characters. 

Using the Simplified Chinese Dictionary Tool application, you can create your own dictionary 
files. To do so, you specify words and phrases and the input codes to enter them. In addition, 
dictionary files are available that contain specialized vocabularies, such as those used in 
medicine or law.
Note: The ABC Standard input mode also lets you enter your own words or phrase using 
the User Dictionary dialog box. (See “Using Abbreviated Input” on page 73.)

Searching the dictionary files can slow down entering characters. While you can use as many 
as four dictionary files, you may not want to do so all the time. You can open and close 
dictionary files using the Preferences dialog box.

To use a dictionary file, follow these steps:

1 Copy the dictionary you want to use to the Extensions folder (in the System Folder) and 
restart your computer.

2 Choose Preferences from the Pencil menu.

The Preferences dialog box shows the dictionary in the Dictionary area.

3 Select the dictionary you want to open and click the Open button.

4 Click OK to close the Preferences dialog box.

To close a dictionary file, open the Preferences dialog box, select the dictionary and click the 
Close button. Then click the OK button to close the dialog box.

Dictionaries in the Extensions 
folder appear here.

Click here to open the selected dictionary.Click here to close the
selected dictionary.

Important  If you select the Search All Dictionaries option in the Preferences dialog box, the 
input mode searches all the dictionaries whether or not they are open. If you do not want to 
use all the dictionaries available, make sure the Search All Dictionaries option is not selected. 
See “Selecting General Preferences” on page 87.
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Editing a Dictionary File

You use the Simplified Chinese Dictionary Tool application to create your own dictionaries or 
edit existing dictionaries.

To use the Simplified Chinese Dictionary Tool, follow these steps:

1 Double-click the Simp. Chinese DictTool icon.

The application is in the Chinese Utilities folder in the Apple Extras folder on your hard disk.

The Simplified Chinese Dictionary Tool application opens and its menu bar appears.

In addition, a new, Untitled SC Dictionary window appears.

Note: The information below the text box shows the number of phrases defined in the 
dictionary, and the amount of free space available in the dictionary.

2 To create a new dictionary, go to step 3. If you want to open an existing dictionary to add 
phrases to it, choose Open from the File menu. In the dialog box that appears, locate the 
dictionary file and open it.

3 Choose the input mode you want to use to enter characters.

File menu

Edit menu

Dictionary menu

Free space in the 
dictionary shown here.

Number of phrases
in the dictionary

appears here.
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4 Choose New Phrase from the Dictionary menu.

The Edit Phrase dialog box appears.

5 Enter at least two Chinese characters for the phrase you want to add to the dictionary in the 
top text box.

The text area below the text box shows the suggested Wubi Xing input keys for the phrase.

6 Enter the input code for the phrase in the bottom text box.

7 Click OK.

The new word or phrase appears in the window.

8 If you are creating a new dictionary, choose Save or Save As from the File menu. In the dialog 
box that appears, select where you want to save the dictionary file, type a name for it, and 
click OK.

To use a dictionary file it must be in the Extensions folder (in the System Folder). So you may 
want to save the dictionary in the Extensions folder. You must restart your computer to use 
the dictionary.

If you are adding a phrase to an existing dictionary file, choose Save.

Choose the New Phrase 
command here.

Enter the new phrase here.

Enter the code for the phrase here.

Click OK here.
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To change the code for a phrase or delete a phrase from the dictionary, follow these steps:

1 Choose Open from the File menu. In the dialog box that appears, locate the dictionary file
and open it.

2 If the dictionary contains a large number of phrases, type the code or enter the Chinese 
characters for the phrase in the text box near the top of the dictionary window.

3 Click the Search button.

The line containing the phrase is selected.

4 Double-click the line containing the phrase to open the Edit Phrase dialog box.

To delete the selected phrase, press Delete or choose Cut or Clear from the Edit menu.

In addition to allowing you to create dictionaries, add new phrases and edit them, the 
Simplified Chinese Dictionary Tool also lets you do the following:
m If you make changes to an existing dictionary and you want to revert to the previous 

version, choose “Revert to Saved” from the File menu.

Enter the phrase here.
Click Search here.

Choose “Revert to Saved” here.
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m To save the phrases and their codes from a dictionary file to a text file, choose “Save as 
Text File” from the File menu.

In the dialog box that appears, select where you want to save the text file, type a name for 
the file, and click Save.

m To add phrases to the open dictionary file from another dictionary file, choose “Add
Phrases From a Dictionary File” from the Dictionary menu.

In the dialog box that appears, locate and select the dictionary file and click Open.
m To add phrases to the open dictionary file from a text file, choose “Add Phrases From a 

Text File” from the Dictionary menu.

In the dialog box that appears, locate and select the text file and click Open.

Resetting Default Preferences

You can reset the defaults for options and the positions of palettes to their factory settings. 
m To reset preferences, choose Reset Default Preferences from the Pencil menu.
m To reset the positions of palettes, choose Cleanup Windows from the Pencil menu.

Choose “Save as Text File” here.

Choose “Add Phrases From a Dictionary File” here.

Choose “Add Phrases From a Text File” here.
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5
5 Troubleshooting

This chapter provides information about problems you may have using the Chinese 
Language Kit.

I can’t read the names of files and folders.

If you have entered Chinese characters for the names of files and folders, the font selected 
for views is not a Chinese character font. For information about setting this font, see 
“Displaying Finder Names in Chinese” on page 18 in Chapter 2.

Dates and times are not displayed as Chinese dates and times.

When you install the Chinese Language Kit, the primary script doesn’t change and it 
determines how dates and times appear on your computer. Although some applications use 
the Chinese formats for dates and times that are defined by the Chinese scripts, others use 
those defined by the primary script.

If you have Mac OS 8 or later installed on your computer, you can display the day of the week 
in Chinese using one of the fonts provided with the Chinese Language Kit. To do so, open 
the Date & Time control panel and click Clock Options. In the dialog box that appears, select 
the “Show day of the week” checkbox and choose a Chinese font from the Font Setting pop-
up menu.

Choosing Edit Dictionary using the Traditional Chinese Input Method does not 
open the Traditional Chinese Dictionary Tool application.

The application is not located in the Extensions folder (in the System Folder). To use the 
Traditional Chinese Dictionary Tool application, drag it to the System Folder and click OK in 
the dialog box that appears to place it in the Extensions folder. Then restart your computer.
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A localized program no longer displays the menus and other items in Chinese 
characters.

If you change the name of a program that you have registered using the Language Register 
application, it is no longer registered.

If you drag the Language Kit Preferences file from the Preferences folder (in the System 
Folder) to the Trash, none of your localized programs will be registered. You need to replace 
the Language Kit Preferences file from a backup copy or register your applications again.

To learn how to register an application, see “Choosing a Language for an Application 
Program” on page 20 in Chapter 2.
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Phonetic Transcription Systems 
for Chinese
Phonetic Transcriptions

Pinyin Yale Wade-Giles Zhuyin

b b p

p p p’

m m m

f f f

d d t

t t t’

n n n

l l l

g g j

k k k’

h h h

j j ch (i, ü)
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q ch ch’ (i, ü)

x s hs (i, ü)

zh j ch

ch ch ch’

sh sh sh

r r r

z dz ts

c ts ts’

s s s

a a a

o o o

e e ê

i i i

er er êrh

ai ai ai

ao au ao

ou ou ou

ei ei ei

an an an

Pinyin Yale Wade-Giles Zhuyin
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en en ên

ang ang ang

eng eng êng

ong ung ung

ia ya ia

iao yau iao

ie ye ieh

iou you iu

ian yan iên

in in in

iang yang iang

ing ing ing

iong yung iung

u u u

ua wa ua

uo wo uo

uai wai uai

uei, ui wei uei, ui

uan wan uan

Pinyin Yale Wade-Giles Zhuyin
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Wade-Giles System Exceptions

uen wen un

uang wang uang

ueng ung ung

ü yu ü

üe ywe üeh

üan yuan üan

ün yun ün

Pinyin Yale Wade-Giles Zhuyin

Description Pinyin Wade-Giles

When preceded by zh, ch, sh, or r i ih

When preceded by z, c, or s i û

When preceded by y e eh


